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2 Logon to EFIS 2.0

2.1 Logon through Go Secure
EFIS 2.0 URL: https://efis.fma.csc.gov.on.ca/workspace/index.jsp

In order to log into the application, you need the Go Secure credential, if you haven’t
registered yet please follow the instructions in the registration Guide
(EFIS_User_Registration_Instructions_Final_English).

The Application link will redirect to a Go Secure login page. Enter your User ID and
Password

3:? Ontario - e

Environment: gdc

GO s sns

GO Secure ID :

Providing secure online resources for individuals within the
‘Ontario and Broader Public Sectors. Password ©

.
GO Secure Profile Don't have an account?

(See your profile, change password or security guestions) _ Register Now

‘GO Secure Login - Delegated Administration
(For administrators of user access and resources) Forgot your ID or password?

CONTACT US | A ITY | PRIVACY | HELP © QUEEN'S PRINTER FOR ONTARIO, 2012 | IMPORTANT NOTICES | ENV ID: GDC SYSTEM ID: 1
LAST MODIFIED: 2014-01-23

Once you click on Sign In you will be directed into EFIS 2.0 application.

¥ & Oracle Enterprise Performance Management System Workspace, Fusion Edition - Windows Internet Explorer (== E3|
&3 () = |&] netpsitest cfistma.csc.gov.on.ca/workspace/indenjsp -~ & [# ] x| [= Bing i o -]
] < Favorites e M Edu:a;an Act - O.Reg. 13... [l Education Act - O. Reg. 13... @& Web Slice Gallery ~
J_Jgo'acle ise P syst || - - [ d=h - Pagew Safety~ Took~ @~
ORALLE" Enterprise Performance Worl Fusion Edition

Done E1 «" Trusted sites | Protected Mode: Off a v #|100% -



https://efis.fma.csc.gov.on.ca/workspace/index.jsp

2.2 Bookmarking the Link

To bookmark the link to EFIS 2.0 you need to create the link once you are in the
application and NOT when you are in the Go Secure screen.

: E— : P ==
(@) Oracle Enterprise Performance Management System Workspace, Fusion Edition - Mozilla Firefor L=

Bookmarks] Tools Help

Show All Bookmarks Cirl-Shift-8

Bookmark This Page Ctri+D

Subscribe to This Page.
Bookmarks Toolbar

Recently Bookmarked
Recent Tags

Moxilla Firefox

L BW [

140aM |

WD o

If you get the error screen below check that the book mark to ensure it is NOT the
following:

https://www.iam.security.gov.on.ca/qgolD/access/index.jsp

it View! Figtory  Bookmarks | Tools el

“ Single Sign-On +

€ ) @ hitps://www.iamsecurity.gov.on.ca/oam/server/auth_cred_submit | |28 Google A
ORACLE

Access Manager

Tip

At the start of a new cycle or if you are having issues connecting to EFIS 2.0 it is good
practice to clear the Browser cache, this is done by selecting the clear recent history
from the browser menu and selecting clear all.


https://www.iam.security.gov.on.ca/goID/access/index.jsp

3 Planning User Set Up

Each Cycle (Estimates, Revised Estimates, etc.) the user must set up there user
preferences.

3.1 Reporting Settings

In order to generate reports, users are required to perform a simple one-time setup of
User Point of View:

In Planning, go to File> Preferences

ORACLE" Enterprise Performance Management System Workspace, Fusion Edition

Edit View Favorites Tools Help

Open

Open in Smart Wiew

Close

Save
Brint

Forn Task List Status
Preferences...

by Ues Log OFff Task List Status - All

s, Exit

B Incomplete
W Complete
M overdue

Incomplete, 100.0%
Task List Status - All

In the popup dialogue, select Financial Reporting on the left pane. In Default Preview
Mode select PDF Preview. In User Point of View, select “On” and click on Setup
Members



Preferences (] 1

7 Finandial Reporting
bo—

Default Preview Mode Export to Office Application:
EI () HTML Preview Office 2002 ~h |
(@) PDF Preview
Authentication
User Point of View Thousands Separator
@ (®) Comma
Financial Reporting ol (O Period
1] () Underscore
s () Space
Web Analysis I Setup Members... I Decimal Separator
() Comma
& (@) Period
Planning Merge Equivalent Prompts () Underscore
() Space

Annotation Print Details. ..

Date Value Format
MMM d, yyyy ¥

Query Ready Mode
(®) Smart View
() Simple Excel

Help oK Cance|
T T

In the resulting Setup User POV dialog, click on the Database Connection dropdown.
There is only one connection for each Planning application, “Main” for input and
calculation.

r Setup User POV (]
-
{ Select a Databasze Connection and then select the members you want to be available to you when using the User Point of View,
a )
Database Connection: FMA_1415 Fssbase |L] Refresh
FMA_1415_Essbase o

FMA_1415_Planning b
FMCCDEV_Planning_Detail

M2015E5T_Planning_Main
MARDEY_Planning_Main T
MCCDEV_Planning_Main
MCCTEST_Planning_Main

MED2_Planning_Main

P 1415FI5_Planning_Main

444 EEOn Flemmiem RA—ie

Select the “Main” database connection. Make the following selections and click Apply:
e Choices List for all dimensions: All Members
e Display Member Label as: Default
e Dimension Labels are: Included

e Member Selection Displays: Only Members | Can Access




Setup User POV (=]

Select a Database Connection and then select the members you want to be available to you when using the User Paint of View.

Database Connection: M20 14FIS_Planning_Main + | Refresh

Cimension Chuoices List

Account All Mernbers m All
Period All Members ﬂ All
Year All Mernbers m All
Scenario All Members H All
Version All Members m All
Recipient All Members ﬂ All
Category All Members m All
SubCategory All Members ﬂ Al
Display Member Label as: Default -

Dimengion Labels are: Induded -

Member Selection Displays Only Members I Can Access  »

* This setting applies to all Planning datasources.

bl [] concel | soovan

Click OK to close the Setup User POV dialog. Click OK to close the Preferences dialog



3.2 Display Options

Once the user has selected an application they are able to set the display preferences.
Select File > Preferences to access the Preferences screen select Planning then
select the desired Number Formatting from the dropdown lists then OK on the
Preferences screen.

Preferences ﬂ
v —| Application Settings § Display Options  JPrinting Options ~ User Variable Options
=
" ’ Number Formatting icati
General
Thousands Separator Comma | v |[]
| a Decimal Separator Dot v | ]
Authentication Megative Sign Parentheses | w|[]
Megative Color Black | v | []
g Page Options Use Application Defauft [
Financial Reporting Remember selected page members Yes | w | []
. Allow Search When Number of Pages Exceeds 100
1 N Indentation of Members on Page Indent based on hierarchy |+ |[]
web Ana.r}rsis Other Options Use Application Default []
’ Show consolidation operators Form Setting | v | ]
>’ Warn if form larger than cells specified soo00| [
Planning UI Theme Normal v
Text Size Hormal v
3 Date Format ¥YYY-MM-DD YO L
i
L
3
' Save Reset
Help oK Cancel

3.3 Setup your Home Page

To set a home page to allow for quick access to your applications select File -
Preferences to access the Preferences screen, select General then select Home Page
from the Content dropdown list then OK on the Preferences screen



I Preferences |ﬂ|
Default Startup Options

Content:

3]

Authentication

&

Financial Reporting

Planning Mormal

Help

Show Path For Documents

= Your e-mail address:
M al.mclaren@manageflow.com

Web Analysis Accessibility Mode

J Select Theme:

|4

3.4 Change Language

3.4.1 Firefox

—

Firefox users can change the Firefox page display to French Language by selecting,

Tools - Options

File Edit View History Bookmarks

Tools | Help

i Oracle Enterprise Perfermance Mana

€& a https://test.efis.frna.csc.gov.on

ORALCLE Enterprise Perforn

Log On

Downloads Ctrl+]
Add-ons Ctrl+Shift+A
Set Up Sync...

Web Developer
Page Info
Monitor with Eiddler

Start Private Browsing  Ctrl+Shift+P
Clear Recent History... Ctrl+5hift+Del

n Edition

I Dptions I

User Name:



In the Options Screen in the Language section select the Choose button,
French/Canada from the Language dropdown list, select Add then Select OK. You will
need to restart the browser for these setting to take effect.

S N i N )
= (.
O &= e O L
General Tabs Content  Applications  Privacy  Security Sync Advanced
[T Block pop-up windows Exceptions...

Load jmages automatically

Enable JavaScript Advanced...

- 201314

Languages =

Fonts & Colors

‘Web pages are sometimes offered in more than one language.
Choose languages for displaying these web pages, in order of
preference.

Default font: | Times Mew Roman VI Size: |16 w | | Advanced...

Colors...

Languages in order of preference:

Languages

English/United States [en-us] Move Up

Remove

Choose your preferred language for displaying pages Choose... English [en]

i

Add

-]

I French/Canada [fr-ca]
L

[ ok | [ concel |[ bep

oK

l e H Help ]

3.4.2 IE

IE users can change the IE page display to French Language by selecting, Tools 2>
Internet Options

File Edit View FavoritesHeIp

Delete browsing history...

Ctrl+Shift+Del
InPrivate Browsing Ctrl+Shift+P
Tracking Protection...

ActiveX Filtering

Diagnose connection problems...

Reopen last browsing session

Add site to Start menu

View downloads Ctrl+)
Pop-up Blocker

SmartScreen Filter

GO Secure ID :

Manage add-ons

Compatibility View
Compatibility View settings

Ontario
Password

I

Subscribe to this feed...

Feed discovery

Windows Update
F12 developer tools

Fiddler
OneMote Linked Motes
Send to OneMote

Forgot your ID or

Don't have a GO §
Register Now.

Internet options

© QUEEN'S




In the General Screen select Language and then add French/(Canada)[fr-CA] from the
Language dropdown list then Select OK. You will need to restart the browser for these
setting to take effect.

——
Internet Options
-

“ GO Secure Login Language Preference
General Jseaurity | Privacy | Content | Connections | Programs [ Advanced |
Home page Language Preference Lg Language Preference B
Add the languages you use to read websites, listing in order of
l/? To areate home page tabs, type each address on its onn line. preference. Only add the ones you need, as some characters can =
E1) o - a
R N i< c7is s cs . gov.on cajworespace/index.jsp [ o gk be used to impersonate websites in other languages.
Add the languages you use to read websites, listing in order of
A preference. Only add the ones you need, as some characters can Language:

be used to impersonate websites in other languages.

fr-CA]
English {United States) [en-US]

[ Use current ] [ Use default ] [ Use blank Language:
English (United States) [en-US]

Move down
Remove

Browsing history

’L Delete temporary files, history, cookies, saved passwords,
¥*) and web form information,

Delete browsing history on exit

Delete... Settings Prefix and suffix options
Search " [ Do not add 'www' to the beginning of typed web addresses
—~ Prefix and suff *dd Language
() Change search defaults. TEX and sut Speadfy' ﬂ'vhe s;;ﬁx (for e:ample .net) that ‘shou'Ldftt)a added to
4 typed web addresses when you press Ctrl + Shift + Enter.
& [7]Do not ade P —
Tabs Spedify the su English [en] Suffix:
. typed web ad dl
Change how webpages are displayed in Estonian (Estonia) [et-£E]
tabs. Suffie: Estonian [1]
Faroese (Faroe Islands) [fo-FO]
Appearance Faroese [fo] S—
P Filipino (Philippines) [fil-PH] =
Colors [ Languages ] [ Fonts ] [ Accessibility ]
French {Luxembaurg) [fr-LU]
b French (Monaco) [fr-MC] =
CONTACT US | ACCESSIBILITY | PRIVACY | HELP User defined: ARIO, 2012 | IMPORTANT NOTICES | ENV ID: GDC SYSTEM
LAST MODIFIED: 2014~

3.4.3 Set Language in Planning

To set the Language in Planning, go to File-> Preferences. Select Planning on the
Preferences screen select French as the Alias setting, select Save then Select OK.

10



Preferences

General

&

Authentication

Financial Reporting

L

Web Analysis

Planning

Help

Display Options

Printing Options | User Variable Options

E-mail Options
E-mail Address
Task List Motification
Approvals Notification
Copy the Application Owner

Job Console Notification

Alias Setting

Alias Table
Approvals Options

Show Planning Units as Aliases

Show Planning Units That are Not Started

out of Office Assistant

Select
Action
Select
Mext
Owmner
Enter
Annotation

Use Application Default [

o [=][1
YESED
No |Z||:|
YESIZ“:‘
Use Appli
French |Z||:|

Use Application Default [C]

Yes|2||:|
o [=]F1

Tam currently out of the office. [

m

Promote

<Automatic>'—

af

m

Save Reset

11



4 Planning Navigation

4.1 Selecting an Application (Doc Set)
The application can be opened using one of the following methods:
To open the application from the menu bar either select > Navigate > Applications

- Planning - application name (where application name is the application you wish
to open), or File » Open = Applications = Planning -> application name

— o
(@ Oracle Enterprise e System Work Fusion Edition - Mozilla Firefox T W | (o e

I il

dit View History Bookmarks Iools Help

——" L eeess sees g

€ | @ hitps://test.efis.fma.csc gov.on.ca/workspace/indexjsp

Pl f

Log OF ©

MOLARENEMANAGEFLOW.COM | Help

b @ MCCDEV

4 MCceElL

=

Workspace Pages » Page I 4 MCCTEST I
& Administer 3
ned ick Links
@ st , bee )| QuickLin
Favorites
Oy I »
g I My Personzl Page.
Applications
Planning
4 MCCDEY
2 MCcETL
4 mocTEST
@ Oracle Enterprise Performance Management System Warkspace, Fusion Editian - Mazilla Firefox - e - — -
| File Edit View Higtory Bookmarks Tools Help
‘{j_} Oracle Enterprise Performance Manage.. |+ | & -w . o
€ | @ https://test.efis.fma.csc.gov.on.ca/workspace/indexjsp 77 7 C | | M- Google 2 #

System Work

Logged in as ALMCLAREN@MANAGERLOW.COM | Help | Log Of O

Dowment.,,  Cu+O
Viorkspece Pages b
URL...
Applications » b Planning » 4 MCCDEV
Refresh 4 MOCETL
4 MoCTEST
Applications
Planning
4 MCCDEY
Lo
4 MecTesT

An alternative way to open applications is use a Home Page (see section 5.3 for setup).

The application can be selected from either the Quick Links or the Recently Opened
list.

12



[/Shared Workspace Pages/HomePage
. | Recently Opened ) Quick Links
Ppne— Favorites
|55 Open... W My Personzl Page
Applications

Planning
4 MCCDEV
4 MCCETL
4 MCCTEST

r‘ | Workspace Pages ‘

Once the user selects the Application using one of the above methods the My Task
List will be displayed. The user will have the choice of using either English or French
Task List.

Logged in a5 ALMCLAREN@MANAGEFLOW.COM | Help | Log Off

-

& Forms | Task List Status

Task List Status - All View w

Query |
¥ Soumission- Entrée et requéte

=
=

|

|

| . I

Incomplete. 100.0%

Task List Tasks - All

[Task. [Type ISEmns Due Date Alert [Completed Date_[Instructions. Action |

=) ) Submission Input and Query - RES_Scumission- Entrés et requéte 5] A
B i Submisson Input and Query ID @ [
@ Input and Results =] @ £
9 Schedule 1.1 - Contracual Service Targets =] 7] ) -

9 Schedule 1.2 - Other Service Targets & @ o

#y Schedule 2.1 - Saffing (Direct Delivery of Services) r el

4 Schedule 2.2 - Staffing (Child Care Administration) e 7] )

9 Schedule 2.3 - Adjusted Gross Expendinres o @ o

“y Schadule 2.4 - Projected Expendinwres I 3 ]

& Schedule 2.6 - Miscellaneous ) [7] o

o Schedule 2.7 - TWOMO Expendimures {onty relevant for DSSABS] e @ )

i v 9 Schadule 3,0 - Allocations for Oparating and Other Purpases = [F] =

4.2 EFIS 2.0 Task List

The Task List provides a central access point to all forms, reports and workflow
activities that are available to each user type. The Task List has been organized to
follow a suggested order of data input.

The Task List is hierarchical. User drills down into lower level tiers of the Task List to
reveal additional detail.

The Task List, when fully expanded is grouped into Input and Results, Reports,
Validation Formats and Submission Management folders.

13



ORACLE’ Enterprise sion n Logged in as AL MCLARENEMANAGEFLOW.COM | Help | Log OFf

-
HomePage | MCCDEV - Task Lis Status Search [ © A=
E Forms Task List Status
¥ Manage Task Lists Task List Status - All Niew
My Task
EL

Bl

Incomplete, 100.0%

Task List Tasks - All

Task [Type [Status Due Date Alet [Completed Date | Instructions Action |

= 9 Submission Input and Query - RES_Soumission- Entrée et requite f 7] & o
1 ) Submission Input and Query lg [F] W
i B Input and Resuhs ) 7] E =
9 Schedule 1.1 - Conracal Sarvice Targets ] [r] o0 B [

iy Schedule 1.2 - Other Service Targets ] 3 o

& Sehedule 2.1 - Staffing (Direct Delivery of Services) ) 7] e

) Schedule 2.2 - Staffing (Child Care B ] @ )

& Sehedule 2.3 - Adjusted Gross Bxpenditures ] @ el

f Schedule 2.4 - Projected Expenditures ] Iﬁ 16a

& Sehedule 2.6 - Miscellaneous ) [=] 69

fp Schedule 2.7 - TWOMO Expenditures {only refevant for DSSABS) ] @ )

i P—— v &9 Schedule 3.0 - Allocations for Operating 2nd Other Purposes ) [F] oa

i Forms Task List Status e
i Manage Task Lists Task List Status - All Wiew v
My Task List

= 7 Submission Input 2nd Query - RES_Soumissi

Incomplete, 100.0%

5 7 Submission Management - Modfier_Gestion

Task List Tasks - All
—

4.2.1 Expand and Collapse Task List

Task Lists are organized into folders that contain cubes, to drill down through folders the
user navigates to the folder, right clicks and selects Expand or the + box next to the
folder. To expand one level of folders select Expand, to expand all the folders below the
selected folder select Expand All Below. To access the Task (Form, Report, etc.) the
user will click on the Cube.

Right arrow points to an example of the folder Icon and the left arrow points to an
example of the Cube Icon.

= Forms
Manage Task Lists
My Task List

=] [ Submission Input and Query - RES_Soumission- Entrée et requéte
= P submissigg 2o Clery

Schedule 1.1 - Contractual Service Targets
e Schedule 1.2 - Other Service Targets
¥ sohedule 2.1 - Staffing (Direct Delivery of Services)

i Schedule 2.2 - Staffing (Child Care Administration)

14



Tarske |l Rt
[y Tarsk Lisl Slaten  Sadimivainn lngsl aadi Quserp Yk w
4 Tpbon of o Tash Loy
[ Lo
= Anar - ] y
[ -
-
"
Haslk Lt Tsles - Sasbosincsioen Inpast s Gpusry
i'-ld Te Ftan Cwm Dl At orrpited [a frakraciora gteny
[ et g e ey 7] (F & -
[ ) r] ]
a0 L v PO DETAL - et r " @& |1
| i 43 i 20 Favelmand - Inpur D_l @& el !
i lcecatnny - It & (F dad &
| i ialid - el Ml iy o Ir 2
B L - Dl Ravene - el Dpesrey. Coetrtate (3 r] e ]
| A 1.0 - Capetal Enpuinciinres - Captal Frioros Somt - (3 r] =
+ I e L B L - e e - Moveabid Akt - irger [Ty & | = I+

Example of right clicking on a folder and selecting Expand will drill down the selected
item to the next level.

Fusion Edition L MCLAREN@MANAGEFLOW.COM | Help | Log OFF

-
MCCTEST - Task List Status * sexrch [ © -

i Forms Task List Status

[ Manage Task Lists Task List Status - All

Wiew w
My Task List

= 7 Submission Tnput and Quary - RES_Soumiss
= PiSbmission Input and Query|

& ® Input and Results

& B Repors |
& B Valdation Formats |
¥ Soumizsion- Entrée ot requite |

Incomplete, 100.0%

Task List Tasks - All

[Task [Type as Dus Date. Alert [Completed Date | Instructions Action
["| |2 2 Submission Input and Query - RES_Soumission- Entrée &t requéte ] [3 B A
B i Submission Input and Query lg [P B i
= 3 Input and Resuhs =3 [¥] B ﬂ
& Schedule 1.1 - Contractual Service Targets N @ ) B
#p Schedule 1,2 - Other Service Targets = Q3 Y §
o Schedule 2.1 - Staffing (Direct Delivery of Services) e 3 ") 5
p Schedule 2.2 - Staffing (Child Care i ) 3 &
fap Schedule 2.3 - Adjumed Gross Expanditures &y [¥] =)
9 Schedule 2.4 - Projected Expenditures. 4 3 &
& Schedule 2.6 - Miscellaneous. =) 7 o
fap Schedule 2.7 - TWOMO Espenditures (onty relevant for DS5ABS) e [F] =y

Example of right clicking on a folder and selecting Expand All Below will drill down the
selected item to the next level.

15



ORACLE’ enterprise Fusion Edition

Fie Edit

Forms J rosk List status =
Manage Task Lists l Task List Status - All View
My Task List

= ® submission Input and Query - RES_Soumissior
& B submission Input and Query

foéSchedule 2.1 - Staffing (Direct Delivery of Services)

Business Rule Security
foSchedule 2.2 - Staffing (Child Care Administration)

Preferences

=] ] Input and Results B Incomplete
© schedule 1.1 - Contractual Service | = i Canpice
& 3 M Overdue
Schedule 1.2 - Other Service Targe
¥ schedule 2.1 - Staffing (Direct Deliy Incomplete, 100.0%
& Schedule 2.2 - Staffing (Child Care | " Task List Status - All =
B9 Schedule 2.3 - Adjusted Gross Expe
¥ schedule 2.4 -Projected Expenditu
- . . Task List Tasks - All
9 Schedule 2.6 - Miscellaneous
@ Task. [Type Status Due Date Alert Completed Date__|Instructions
W
e Schedule 2.7 - TWGMO Expenditurd =l ) Submission Input and Query - RES_Soumission- Entrée et requéte |l 7]
Schedule 3.0 - Alocations for Oper: = 2 Subission Tnput and Query £} ¥
& schedue 3.1 5 =1 §9Input znd Results E) 7]
« i r f@Schedule 1.1 - Contractual Service Targets [} 7]
Dimension fiSchedule 1.2 - Other Service Targets & r]

g/gg g

Right clicking on an expanded folder in the Task List and clicking Collapse or the - box
next to the folder to collapse one level or click Collapse All Below will hide all of the
levels below the selected folder.

— il
@ Oracle Enterprise e System Fusion Edition - Mozilla rm@g

File Edit View History Bookmarks Iools Help = —

| Oracle Enterprise Performance Manage... [ + | 5 - Pp— - _m w
€ & nip
ORACLE Enterprise

ftest.efis.frma.csc.gov.on.ca/workspace/index.jsp vr v & | M- Googie 2w

Fusion Edition Help

I ©

H Formes Task List Status B
B Manage Task Lists Task - Input and Results | Task Instucions
My Task List Stamuz Incomplete

7 Submizsion Input 2nd Queny - RES_Soumiss & Complesed Date
= B Submission Input and Queny, Complete No
J = Due Date

Collapse Al Below

¥ schedule 2.6 - Miscellansous
¥ Schedule 2.7 - TWOMO Expenditu
1 ¥ Schedule 3.0 - Allocations for Opes
B Schedule 3.1
M 9 Sehedule 4.0 - Mitigation Funding
8 ¥ schedule 4.1 - Capial Carmy Forw
¥ Schedule 4.2 - Par Diem Rates
' Datz Anslyss 2nd Review

m

tarance Report
1 B Errors 2nd Wizrmings
& 7 Repons
@ P valdstion Formats 52
Qe I

E Dimension
i Business Rule Security
& Preferences

Complete: Previous Incomplere || Previous || Next Incompiete || Newt || Task List Home

Example of selecting Collapse.
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ORACLE' Enterprise ) [ -  ALMWCLARENGMANAGEFLOW.COM | Help | Log OFF O i

-

 Forms Task List Status

Task - Input and Results | Tssk Insuctions U

& Forms Task List Status =

My Task List Task - Input - Task Instructions
I iSubmission Input and Query

Status Incomplete
Completed Date

Complete No

Due Date

@ preferences Complete Previous Incomplete || Previous || NextIncomplete || Next || TaskListHome

4.3 How to Navigate in Planning using Task List

To drill down to any form in EFIS 2.0 Task List click on the Expand icon (+) next to
desired Task List. A list of folders/cubes for each area will be displayed. The Input and
Results folder contains all the data input forms. The Reports folder contains reports for
all Schedules,) and other Efis2.0 reports. The Validation Formats folder contains valid
data formats for all input forms. The Submission Management folder contains tasks
related to validation and promotion of the submission.
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=]

Sescch [ © Acvarced

& Forms Task List Status =+

{ Task Instrucions

ncomplete

9 Saumission- Entrée et reguite.

< m ] v

& Dimension

4.3.1 Input and Results Data Navigation

All data input forms are contained in the Input and Results folder. To access the
individual forms expand the Input and Results folder.

ORACLE’ enterprise

Forms Task List Status

Manage Task Lists Task List Status - All View v

uery - RES_Soumissior %

uen

g - W incompiete

& schedule 1.1 - Contractual Service | = e
3 W overdue

9 schedue 1.2 -Other Ser

¥ Schedule 2.1 - Staffing

¥ schedule 2.2 - Stafing (¢
9 Schedule 2.3 - Adjusted Gross Expe

Incomplete, 100.0%
Task List Status - All

¥ schedule 2.4 - Projected Expendity

Task List Tasks - All
9 scheciile 2.6 - Miscellansous

B schedul [Type Status Due Date Alert Completed Date | Instructions

Schenie st TON 'd Query - RES_Soumission- Entrée etrequéte | [l @

9 schedule 3.0 - Allocation: =) @ (I

9 Schecuie 3.1 i E3 o
E F—— v o ] -
imensi fpSchedule 1.2 - Other Service Targets & @ =
Business Rule Security fSchedule 2.1 -Staffing (Direct Delivery of Services) & ] 50

fpSchedule 2.2 - Staffing (Chid Care Administration) & [%] =) A

Preferences

4.3.1.1 Variance Report - Input

The new Variance Report — Input form is where the recipient now enters an explanation
for any variances that has a “Yes” value. This has replaced the external excel report. A
new error has also been added that will not allow the submission to be submitted until
all explanations been entered.

Example of Variance Form
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ise Performance

Navigate File Edit

A B 2 Bgoe |5 @ &

Fusion Edition

Logged in a5 EFIS. TRAINERO 1@GMAIL.COM | Help | Log Off

i

& Forms

My Task List
51 ¥ Submission Input and Query - FS_Soumission- En
&1 submission Input and Query
8 P 1nput and Resuits

¥ Schedule 1.1 - Contractual Service Tar
& Schedule 1.2 - Other Service Targets
9 Schedule 2.1 - Staffing (Direct Deliver
& Schedule 2.2 - Staffing (Chid Care Ad
89 Schedule 2.3 - Adjusted Gross Expend
¥ Schedule 2.4 - Projected Expenditures
9 Schedule 2.6 - Miscellaneous

Task List Status

Task - Variance Report-VAR

Task Instructions

4 Period: YearTotall

= | Redpient Working Version

-3

[# vear: 2014

Financal Statements

Financial Statements

Variance Check Actual Results

Variance

Variance Check Expected Results

Variance Amount | Did Variance Check Fail?

Impact on staffing a|

Schedule 1.1 Variance Checks

O Schedule 2.7 - TWOMO Rei

& Schedule 2.8 - Capacity Funding to Su
9 Schedue 3.0 - Alocations for Operatn
9 schedule 3.1 - Entitiement

B Schedule 4.0 - Mitigation Funding

& Schedule 4.1 - Capital Carry Forward
9 Data Analysis and Review

¥ Guideline Adherence Confirmation

o ‘Variance Report

P Errors and Warnings

~ Reparts

F validation Formats
P goumission- Entrée etrequéte
¥ submission Management - Modifier_Gestion dela

Fee Subsidy 192 195 3| No /Nen
Text
Special Needs Resourcing 7 51 24
Cntario Works and LEAP - Farmal k) 7 0 No /Non
Ontario Works and LEAP - Informal 5 5 0 | N /Non
(| | schedule 2.3 Variance Checks
General Operating 1,512,764 3,900,000 2,387,236
Fee Subsidy - Regular 1,200,000 (1,200,000)
Fee Subsidy - Extended Day 105,000 10,000 (35,000)
Fee Subsidy - Recreation 0 0
Gntario Works and LEAP - Formal 740,000 (740,000)
Ontario Works and LEAP - Informal 25,000 (25,000)
Pay Equity Memorandum of Settiement 94,527 (94,527)
Special Needs Resourcing 162,593 300,000 137,407

.

4.3.1.2 Errors and Warnings Navigation- Input

The Errors and Warnings have been separated into 2 input forms,

1 for errors and one

for Warnings. The Warnings form now includes a new field for the Warning Explanation
where the recipient now enters an explanation for any warning that message that has a
“Yes” value. This has replaced the external excel report. A new error has also been
added that will not allow the submission to be submitted until all explanations been

entered.

Example of Warning Explanation Form
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Fusion Edition

M2014FTS - Task List Status *

s EFIS. TRAINERO 1@GMAIL.COM | Help | Lo

Forms

My Task List
= # submission Input and Query - FS_Soumission- *
2 ¥ submission Input and Query

2 P input and Results
¥ Schedue 1.1 - Contractual Service

9 Schedule 1.2 - Other Service Targe
9 Schedule 2.1 - Staffing (Direct Dely
& Schedule 2.2 - Staffing (Chid Care
& schedule 2.3 - Adusted Gross Expe
O schedule 2.4 -Projected Expendiu
¥ schedule 2.6 - Miscellaneous

@ Schedule 2.7 - TWOMO Reimbursen|
89 Schedule 2.8 - Capadity Funding to
& Schedule 3.0 - Allocations for Oper.
O Schedule 3.1 - Entilement

B9 Senedule 4.0 - Mitigation Funding

9 Schedule 4.1 - Capital Carry Forwal
59 Data Analysis and Review

¥ Guideline Adherence Confirmation
& Variance Report

& P Errors and Warrings

¥ Warnings

& Errors

P peports

9 aldation Formats

I soumission- Entrée et requets

B sybrmission Managemen - Modifier Gestion de ™
[ 13

< |

Task List Status

Task - Warnings-Warnings . Tack Instructions

Recipient Working Version

#Period: YearTotal1

[ vear: 2014

- 3]

cenario: Finandal Statements

4, Category: N Category

Valuel |value2| Warning? | Warning Description - Engiish
Please verify that all requirements as outined in the “Cntario Chid Care Service
Warning on Guideline Adherence No MNon Management and Funding Guideline™ have been adhered to by the CMSM/DSSAB. I
If the number of licensed programs supported for SWWY has been entered (Value 1),
Warning_5C1.2_1 22| 4,125 No [Non ensure there are expenditures reported on Sch 2.3 for SW\W (Value 2)
test If the number of contracts {head offices) for Pay Equity has been entered (Value 1),
Warning_SC1.2 2 2 0 ensure there are expenditures reported on Sch 2.5 for Pay Equity (Value 2)
=] Schedule 1.2 Warnings
Test If Salaries have been entered on Schedule 2.1, Benefits should not be zero
Warning 5€2.1_1 2,200,000 0
E] Schedule 2.1 Warnings
Test If Salaries have been entered on Schedule 2.2, Benefits shouid not be zero
Warning_S€2.2_1 15,000 0
= schedule 2.2 Warnings
Test The Required Parental Contribution should not be blank
Warning_SC2.3_1
] Schedule 2.3 Warnings
test Expenditures (Value 1) should not exceed system needs expenditures from 2012
Warning_SC2.6_1 200,000 0 (Value 2)
] Schedule 2.6 Warnings

Preferences

Complete || | Previous Incomplete || Previous

Next Incomplete

Dext

Task List Home

The Error form now contains a new Recipient Accepted Error Confirmation dropdown
that allows the Recipients to submit with outstanding errors as part of the Submit with
Errors process. This functionality is only used after consulting the Ministry. Warnings
can also be viewed as a tab on this form.

ORACLE enterprise Performance Management System Workspace, Fusion Edition

M2014FIS - Task List Status *

Forms

&9 Schedule 1.2 - Other Service Targe
& Schedule 2.1 - Staffing (Direct Dely
&9 Schedule 2.2 - Staffing (Chid Care
& Schedule 2.3 - Adjusted Gross Expe
&9 Schedule 2.4 - Projected Expenditu
& schedule 2.6 - Miscellaneous

O Schedule 2.7 - TWOMO Reimbursen
& Schedule 2.8 - Capacity Funding to
&9 Sehedule 3.0 - Alacations for Oper
& schedule 3.1 - Entitiement

9 Sehedule 4.0 - Mitigation Funding
& Schedule 4.1 - Capital Carry Forwal
&9 Data Analysis and Review

& Guideline Adherence Confirmation

o Variance Report

B P Errors and Warnings
& Warnings

o Ervors

B Reports
B aiidation Formats

P soumission- Entrée etrequéte

¥ Submission Manacement - Modifier Gestion
4 m | I3

[*I Preferences

My Task List Task - Errors-Errors
& # submission Input and Query - FS_Soumission-
=]
N Sl bt vl ey Redipient Working Version
5 B tnput and Resuits
& Schedule 1.1 - Contractual Service

J resk st status
Task Instructians
4 Period: YearTotall 2 Year: 2014 Scenario: Financial Statements 1 Category: No Category 3]
g
- - &
Vauei | [Values | Error? | Redpient Accepts Ertor Desaription - English g
Indicatell if there is any error in the submission and =3
No SubCategory whetherlita proceed with submission regardless of error g
E]
=
7
@
No data has been entered for this schedule (total &
Error_SC1.1_1 No /Non Schedule 1.1) i)
=] Schedule 1.1 Errors E
The number of chidren served on Schedule 1.2 (Value
Ermor_SCL2_1 195 222 Mo /Non 2) should exceed the average monthly number of
The number of chidren served on Schedule 1.2 (Value
Error_SC1.2_2 51 222 | No /Non 2) should exceed the average monthly number of
The number of chidren served on Schedule 1.2 (Value
Error_SC1.2_3 7 222 Mo /Non 2) should exceed the average monthly number of L4
The number of chidren served on Schedule 1.2 (Value
Error_SC12.4 5 222 | Mo /Non 2) should exceed the average monthly number of
=] Schedule 1.2 Errors
The FTE in Column 3 cannot exceed the number of
Error_SC2.1_1 Mo [ Non staff reported in Column 2
No data has been entered for Number of haurs with
Ermor_SC2.1.2 Mo /Non "YES” drop down selected
5] Schedule 2.1 Errors
The FTE in Column 3 cannot exceed the number of
Error_SC2.2_1 Mo [ Non staff reported in Column 2
No data has been entered for Number of haurs with
Error_S€2.2_2 Mo /Non "VES" drop down selected
Complete [] | Previous Incomplete || Previous || NextIncomplete || Next | TaskListHome
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4.3.2 Reports Data Navigation

Reports displaying the input and results for each form are found under the Reports
folder. Reports have been grouped by Schedules, Errors and Warnings, Variance
Report and Data Analysis and Review. To print a complete set of reports the user will
select the Report Book folder.

Example of the Report Area folders

ment System Workspace, Fusion Edition

Forms Task List Status

Manage Task Lists
My Task List

Task - Reports " Task Instructions

2L Status Incomplete
= I submission Tnput and Query - RES_Soumissior Completed Date

= submission Input and Query Complete No
Due Date

& PiReports!
9 Certficate

& ' schecile 1.1 - Contractual Service |
[N»-‘ Schedule 1.2 - Other Service Targe
@ B schedue 2.1 - Staffing (Direct Deliv
@ P schedule 2.2 - staffing (child Care
P Schedule 2.3 - Adjusted Gross Expe
) 9 Schedule 2.4 - Projected Expenditu
9 Schedule 2.6 - Miscellaneous
9 Sehedule 2.7 - TWOMO Expenditure _
L ——— v
Di

Business Rule Security

[ — Comnlate Previous Incomolete || Previous || NextIncomolete || Mext || TaskListHome

To view the complete description position the mouse pointer on the edge of the
description cell and drag the cell to expand. See arrow above

4.3.3 Validation Formats Navigation

Each of the input cells requires valid data formats to be entered before the data will be
saved to the system; the Validation Formats folder contains validation forms for each

input form.

21



Fusion Edition Logged in as EFIS.TRAINEROI@GMAIL.COM | Help | Log OFF

; Bo ==K <
-
(IR M2014FIS - Task List Status * search [ © -5~
# Forms Task List Status
My Task List Task - Schedule 1.1 Schedule 1.1 Format FS | Tack Instructions
o B = |
= ¥ Submission nput and Query - Fe_seumissonfl [\ L T eien Targets
& ¥ submission Input and Quer
N i Query 4, Period: YearTotall vear: 2014
# P 1nput and Results
- | [ Recipient Warking Version - e aFormat [ [#]
& B Repons
2 B validation Formats Avg Manthly Number of Chidren Served
@ - Infants Toddkrs Preschoolers x 3 Up ta and Including SK
1 ¥ Schedule 1.1
p ‘SUPPORTED WITH PROVINGIAL FUNDING AND REQUIRED COST SHARE ONLY
9 Schedule 1.2 =
p ‘SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNL. DES COUTS REQUISE SE
A 9 schedule 2.1
A 9 schedule 2.2 -
2 cchedle 23 Fes Subsidy +00 +00 +00 +00 +00 +00
P Service Target 1 Non-Input { Pas dentrés Non-Input / Pas dentrés Hon-Input / Pas dientrés Non-Input / Pas dientrés Non-Input / Pas d'entrés Non-Input { Pas dentrés Non-
9 schedule 2.4
9 schedule 2.6 :
2 Schedule 27 ‘Special Needs Resourcing +00 +00
26 Schedule 28 Service Target 2 Non-Input { Pas dentrés Non-Input { Pas dentrés Non-Input | Pas d'entrés Non-Input | Pas dentrés Non-Input [ Pas d'entrés Non-Input { Pas dentrds Non-
7 ¥ schedule 31 s
¥ Scheduke 4.0 Gntario Works and LEAP - Formsl +00 +00 +0.0 +00 +00 +00
9 Schedule 41 Ontario Works and LEAP - Informal
e P - Entrée ste Total Service Target 3 Non-Input { Pas dentrés Non-Input / Pas dentrés Hon-Input / Pas dientrés Non-Input / Pas dientrés Non-Input / Pas d'entrés Non-Input { Pas dentrés Non-
& ¥ soumision- Entrée ot requéte
1 ¥ Submission Management - Modifier_Gestion deff | |-
COMPLETE VARIANCE REPORT IF ANY WARIANCE CHECK FAILED
REMPLIR LE RAPPORT DES ECARTS EN CAS DECHEC DE VERIFICATION DES ECARTS

The chart below provides a listing of all input formats.

Description Format Code
Non-Input Cell Blank Cell
Non-Input Cell Non-Input / Pas d'entrée
All Values, No Decimal +/-0

Positive Values, No Decimal +0
Negative, No Decimal -0

Positive One Decimal +0.0
Negative One Decimal -0.0

One Decimal +/-0.0
Positive Two Decimals +0.00
Negative Two Decimals -0.00

Two Decimals +/-0.00
Positive Three Decimals +0.000
Negative Three Decimals -0.000
Three Decimals +/- 0.000
Positive Four Decimals + 0.0000
Negative Four Decimals - 0.0000
Four Decimals +/- 0.0000
Positive Five Decimals + 0.00000
Negative Five Decimals -0.00000
Five Decimals +/- 0.00000
Positive Six Decimals + 0.000000
Negative Six Decimals -0.000000
Six Decimals +/- 0.000000

4.3.4 Submission Management Navigation

The Submission Management folder contains tasks used to perform Version
Management submission and promotion activities (promotion of the Recipient working
version). The Version Description and Summary form is where the Recipients can
enter a description for the version user is working on as well as follow the activities on
different version in the application.
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Example of the Version Description and Summary form

Fusion Edition

ORACLE" Enterprise
Navigste Fle Edt :

A fe % Explor

[0Sl M2014FIS - Task List Status *

Logged in as EFIS.TRAINEROIEGMAIL.COM | Help

Log off O

al

# Forms

Task List Status

My Task List

=1 ¥ Submission Input and Query - F5_Scumisson
& P Submission Input and Query
& 7 Scumission- Entrde ot requite

=1 7 Submission Management - Modifer_Gastion d=
= 7 Submission Mansgement

# ¥ Version nd Summary

Task -

Task Instructions

£} Scenaria: Financial Statements

) Submission Status

#:,Period: YearTotall

[ Year: 2014

4. Category: No Category

). SubCategory: No SubCategory

‘Submission Status

Activation Date

Submission crested by

TP Activation Date

TP Process Complete

7 ¥ Flag Submission for Approval

jent Active Version | Nt Act

V20:FA Active Version

Nt Acti

& ¥ Validate and Promote for Approval

& P Gastion de la soumission

] Version Deseription and Summary

i Version Description Activation Date | Version Description =
V10W:Recipient Working Version I VI0ERO:Recipient Error Override Version e
ient Draft 1 sient Active Version
ient Draft 2 jient Inactive Version 1 2015/02/10
V10D03:Recipient Draft 3 V10102:Recipient Inactive Version 2 2015/02/06 =
V10004:Recipient Draft 4 £ sent Inactive Version 3
V10D05:Recipient Draft 5 V10104: Recipient Inactive Version 4
V10D06:Recipient Draft & V10105:Recipient Inactive Version § L
V10D07:Blank Tempste For Resst V10106:Recipient Inactive Version &
V10FOV:Recipient FA Viewable Version vient Inactive Version 7
0 V20:FA Active Version t 'V10108: Recipient Inactive Version 8 %
« I =
& Preferences Compiste [[] | Previous Incomplete || Previous || Next Incomplete || Next || Task List Home ]

4.4 Navigation Using Forms

An alternative way to access forms (Input and Results and Format) without using the
Task List is to select Forms in the Planning Explorer window, and then select the
Schedule in the Form folder window, and then select the form the user wants to access.
The example below shows how to access the Input and Results form for Schedule 1.1.
Unlike the Task List, the Input and Results and Format forms are grouped together.
Reports cannot be accessed through Forms.

ORACLE Enterprise

Fusion Edition

Navigste Fie Edit
& & 4 e
[l M2014FIS - Schedule 1.1_FS X
Forms Schedule 1.1_FS
= Form Folder Bl Schedule 1.1 - Gontractual Service Targets
= Forms i 4 Period: YearTctall 9 vear: 2014
i Fs 5
&= Cammon ~ [~ 21
se Total
—_
o L Financial Statements
cerz Service Agreements - Avg Monthiy Number of Chidren Served
P Infants | Toddlers | Preschooters | JK | 5K | Up to and Including SK | School Aged | Recrestion | Informal | £ Contractusl Service Targsts Enrolment G
sCz4 ‘SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY
sc26 SOUTENU PAR DU FINANGEMENT PROV. ET LA PART MUNL. DES COUTS REQUISE SEULEMENT
sC27
sc30 -
#5c31 _ ] |Feesuessy H 2 ss|23| 20 4 ]
al .l Service Target 1 4 3z 8| 30 45 0
=l Forms in SC1.1
o Specal esds Resourci 2 2
[, Schedule 1.1 Format_F5 pecs —to
% Scheduke 1.1 EST Service Targst 2 = 2
" Scheduke 1.1_F5
i 1abkau L1 Formal P> Ontario Works and LEAP - Farmal 10 1 2|10 3 3
B Tableau 1.1_EST Onfario Works and LEAP - Informal s
7% Tableau 1.1_FS
Total Service Target 3 w0 0 32|10 3 3 5
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5 Data Input

5.1 Data Input and Results — Forms

All data to be entered into EFIS 2.0 is entered using the data input forms. As described
above, each section has a form or set of forms for data input. White Cells are data input,
Blue Cells are loaded with prior year data, Gray Cells are non-input cells and Red Cells
indicate a data validation error.

The section below explains how to input data into EFIS 2.0.

5.1.1 Opening a Form

To open a Form in the Task List click on the forms name.

jement System Workspace, Fusion Edition

[ Task List Status

Task - Schedule 1.1 - Contractual Service Targsts-Schedule 1.1_FS  Task Insructions

= Schedule 1.1 - Contracwal Sarvice Targers

4, Period: YearTotall ¥ Yean 2014
s

p e [Resipient Viorking Vession )
* Schedule 1.1 - Contractual Se| Brroan . —
B ™ Scheduie 1.2 - Other Service Targefj | | S=rvice Agreements | Wotall. Reconciiiation | Netes

Financisl Statements Financisl Statements.
Avg Monthhy Number of Chiiren Served Did Variance Check Fail?
Infants| Toddlers | Preschoolers | 1K 5K Up 10 and Including Sk | Sehool Aged | Recrestion| Informal | = Gontractual Service Tangets Envolment hedul 1,1 Variance ChecH

‘SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY
'SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNI. DES COUTS REQUISE SE|
Fes Subsidy It} ) 54/24[20 B 1 195 | Mo / Non
Service Target 1 12 M 5424/ 20 50 1 135

o Special Needs Resourcing 30 1 31 | Yes | Oui

viall | | Service Targer 2 30 1 31
‘Ontario Works and LEAP - Formal s 1 2|10] 3 e 78 | No f Non
Ontaro Works and LEAP - Informal ﬂ s 5| Mo/ Nen

‘COMPLETE ¥ ARIANCE REPORT IF ANY VARIANCE CHECK FAILED

REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECHEC DE VERIFICATION DES ECARTS)

EFIS 2.0 displays the form that applies to the particular task.

Total Service Target 3 sl n n 1£| 3 e s £

The Schedule 1.1 input/results form is a complex form with multiple tabs. The Schedule
input forms are either a single form (one tab) or a complex form (multiple tabs)
depending of the amount of information to be entered.

5.1.2 Enable Input Field

Input fields are displayed with a white background, to enable an input field for input click
in the cell. The selected input field is now enabled.
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ORACLE Enterprise Performance Management System Workspace, Fusion Edition

1L.COM | Help | Log O

& Forms

Task List Status

My Task List
= I Submizsion Tnput 2nd Queny - FS_Saumissia)

B P Submission Input and Query

&= 7 1nput 2nd Resuls

¥ Schedule 1.1 - Contractual Se
¥ Schedule 1.2 - Other Service Targe]
o Schedule 2.1 - S
& Schadule 2.2 - Saffing |
¥ schedule 2.3 - Adg
o Scheduie 24 -
& Schedule 26
¥ Schedule 2.7 -
o Schedule 2.8~
¥ Schedule 3.0-
& Schedule 3.1 -
¥ Schadule 4.0 - Misigstion Funding
¥ Schedule 4.1 - Capital Camy Farwg
¥ Data Analysis and Review

ERC]

HE 8

IOMO Reimburses
Capacity Funding to|
Allocations for Oper
Entitlement

IEEEEEEEEEE

& Repons
& P validation Formats

Task - Schedule 1.1 - Contractual Service Targets-Schadule 1.1_FS Tzt Insrumions

 Schedule 1.1 - Contractuzl Service Targets
£, Periodi YesrTotall

|+ [Resips -

Service Agreements [[ToEIN Reconciiaton | Neres

4 Yeen 2014

Financial Statements

Financial Statements

Avg Monthy Number of Chikren Served Di Variznce Check Fai?
Infants| Toddlrs | Preschoniers | K 5K | Up t 2nd Incucing SK| Schosi Aged | Recestion| Informl | = Conacus! Service Targers Eolment Groupe Schecuie 1.1 Variance Checi]

SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY

SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNL. DES COUTS REQUISE SE

Fee Subsidy 2 P |2 | AE s 1 155 Mo / Nen

Service Target L 12 E.] 424 20 50 1 195

‘Special Ness Resourcing 0 1 31| Yes | Oui

Service Target 2 0 1 31

‘Ontario Works and LEAP - Formal 5 11 3210 3 13 78 | No / Non

‘Onario Works and LEAP - Informal 5 5| No/Non

orsl Service Targsc 3 sl u 3210 3 5 s a3

'COMPLETE VARIANCE REPORT IF ANY VARIANCE CHECK FAILED

REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECHEC DE VERIFICATION DES ECARTS|

& 7 Soumission: Envée et requite

To navigate between cells, in addition to mouse navigation, the keyboard can be

utilized:

Enter —

5.1.3

move to the next cell

Shift Enter — move back to last cell

Key in Input Field

Tab — move selected cell to next cell in horizontal order

Shift + Tab — move selected cell backwards, in horizontal order

Once an input field is enabled the user can key a value into the cell. A dialog box will be
displayed indicating the EFIS 2.0 Cell Coordinates

Fusion Edition

System Works,

* Forms

Task List Status

My Task List
= P Submission Input and Query - FS_Soumissio
= I submizsion Tnput 2nd Quary.

P 1ot and Resufts

¥ Schedule 1.1 - Contractual Se
.2 - Other Service Targe]
.1 - Staffing (Direct Deliv
.2 - Staffing (Child Care
- Adjusted Gross Expe)
- Projectad Expenditu

HEHES®

.6 - Miscellaneous
.7 - TWOMO Reimburser
pacity Funding to
.0 - Allocations for Oper
9 Schadule 3.1 - Enttlemant

¥ Schedyle 4.0 - Mitgstion Funding
9 Schedule 4.1 - Capital Carry Forwea
¥ Datz Anzlysis ané Review

®

HEEE @B

1

Validation Formats

Task - Schedule 1.1 - Contractual Service Targets-Schedule 1.1_FS | Task Instuctions

5 Schedule 1.1 - Contractual Service Targets
1, Perod: YearTerall

- [Recp -2

‘Service Agreements | Wotall}{. Reconciistion | Notes

4 vear 2014

Financial Statements Financial
Avg Manthly Number of Chikiren Served Did Variand
Infants | Toddlers | Preschooters | 3K | 5K | Up t and Inchuding 5K | School Aged | Recreation | Informal | & Contracwal Service Targets Enrolment Groups | Schedule 1.1
‘SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY — - - -
‘SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNI, DES COUTS REQUISE SEULEMENT — - - - - - 1
Row Fee Subsidy, Column Financial Swtements Avg
Manthly Number of Chikiren Served Preschooters |
Fee Subsidy 12 34|81 24|20 50 1 195 | No / Nen
Servica Targes 1 © B 4[24 20 s 1 155
‘Special Nesds Resourcing 30 1 31| ves f Oui
Service Target 2 30 1 31
‘Ontario Works and LEAP - Formal 9 11 2|10| 3 13 78 | No / Nen
‘Ontario Works and LEAP - Informal 5 5| No / Nen
Total Service Target 3 L] 1 2w 3 13 5 83
'COMPLETE VARIANCE REPORT IF ANY VARIANCE CHECK FAILED
REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECHEG DE WERIFICATION DES ECARTS

The system highlights input values in yellow until they are saved to the database.
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I 1
Fee Subsidy 2 GAE: |B:] 50 1 195 | Na / Non
Serviee Tamer 1 2 sl = s 1 195
‘Specisl Needs Resouting k') 1 31 |Yes / Oui
Service Target 2 ko) 1 3
Ontario Wiorks and LEAP - Formal s 1 2|w| 3 1 78| No/ Nen
Ontaria Works and LEAP - Informal 5 5| No/ Nen
Total Servie Targer 3 s 1 2w 3 13 s 5
COMPLETE VARIANGE REPORT IF ANY VARIANGE CHECK FAILED
REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECHEC DE VERIFICATION DES ECARTS

2 P Submission Manacement - Modier Geston

5.1.4 Save input field

To save data keyed in an input field click on the Save icon or File > Save

ORACLE Eenterprise Performance M:
e — S———

anagement System Workspace, Fusion Edition

Ip

M2014FIS - Task List Status *
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¥ Schedule 1.1
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4 Period: VearTotall

-l

¥ Srhedule 1.2 - Other Servics Targe]
& Schedule 2.1 - Staffing (Direct Delif
B Schedule 2.2 - Staffing (Chid Care:
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¥ Schedule 2.4 - Projected Expenditu
8 Schedule 2.6 - Misceliznesus
B 9 Schedule 2.7 - TWOMO Reimbursat
B ™ Schedule 2.8 - Capacity Funding to|
¥ Sehedule 3.0 - Allocations for Oper:
18 9 Schadule 3.1 - Encriement
Schedule 4.0 - Mitigation Funding
9 Schedule 4.1 - Capital Carry Forn
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& # soumission- Emrée et requi

Service Agreements | Total . Reconcilizton | Notes

) ear: 2014

Financial Statement Financial
Avg Monthly Numbes of Chidren Served Did Varizno]
Infants [ Toddlers | Preschoolers | JK| 5K [ Up to and Including 5K School Aged | Recreation | Informal | = Contractual Service Targets Envolment Groups | Schedule 1.1
'SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY
SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNI, DES COUTS REQUISE SELLEMENT
Fee Subsidy: 2 El} €12 0 50 1 195 | No/ Nen
Servies Tamer 1 It} 4 54|24| 20 e 1 155
‘Specisl Nesds Resouting E) 1 31 | es / oui
Service Targer 2 k! i £
o] | | omario Viorks 2nd LEAR - Formal 9 1 2|0 3 3 78 | No/ Nen
Ontaria Works and LEAP - Informal s 5|No/ Nen
Total Servie Target 3 s 1 2w 3 13 s )
COMPLETE VARIANGE REPORT IF ANY VARIANGE CHECK FAILED
REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECHEC DE VERIFICATION DES ECARTS

5 B Submission Manaoement - Modiier Gastion

The system confirms that the data has been saved.
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 Forms Task List Status |
My Task List 11 i gets 125 Task Instucions
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& P Submission Input and Queny
B P 1Input and Resuits
¥ Schedule 1.1 - Contractual Se|

e — 8 Year 2014
|@ Information

Messages for this page are listed
bel

Schedule 1.2 - Other Service Targe] o
9 Schedue 2.1 - Staffing (Direct Dsiiy @ The data has been saved. Financial Gratements Financal
51 9 Schaduie 2.2 - Stafing (Chid Care (@ e was run succmssly foug Monehy Numbes of Giren Served ) Di
i it 23 Adgemedtins honl 3K[ 5K Up 10 and Incuding 5K | School Aged | Recreation | Informel | = Contractuzl Gervice Targets Envolment Schedule 1.1
2 cehasie 2.4 - prejeced Expendn || |SUPPORTED WATH PROVINGIAL FUNDING AND REQUIRED COST SHARE Of | ok |
5 9 Schadule 2.6 - Misoellansous SOUTENU PAR DU FINANCEMENT PROY, ET LA PART MUNI, DES COUTS REQUISE SEULEMENT
8 O Schedue 2.7 - TWOMO Reimbursedl | |-
% Schedule 2.8 - Capaciy Funding 1o | | | Fes Subsdy 2 2] 61| 24| 20 e 1 202| Na / Non
Schedule 3.0 - Allocations for Operal) | | Service Terget 1 2 = 6124 20 s 1 m
8 9 Schedule 3.1 - Entitement :
Schedule 4.0 - Mitgation Funding ‘Specisl Neads Ressurcing ) 1 31| ves/ Owi
9 Schedule 4.1 - Capial Garry Forwal | | Service Target 2 20 1 3
Dats Anshyss and Review .
5 ™ Guidsline Adherence Confirmation Ontarin Werks 3nd LEAP - Farmal s 1 32/10 3 13 78| No / Nen E
* Varisnce Repart Ontaris Works and LEAP - Informal s 5| No / Nen
& ¥ Emors and Wamings Total Service Targst 3 3 u 32|03 3 5 ]
COMPLETE VARIANGE REPORT IF ANY \ ARIANGE GHEGK FAILED
=t REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECHEC DE VERIFICATION DES ECARTS
m ¥ yalidstion Formars
1 7 soumission. Entrée 2t requite
= 17 Submission Mznzgement - Modfizr_Gestion

Click on OK to continue.

5.1.5 Invalid Data

When the user enters and saves data that is invalid the invalid cell is highlighted in red
and a Data Validation Message is displayed on the right side of the form.
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& Forms Task List Status K
My Task List Task - Schedule 1.1 - Contractual Service Targets-Schedule 1.1_FS | Task Instructons
[ Input 2 . -
Submission Input 2nd Query - FS_Soumissoll [ cotsite 1.1 - Conpamus! Servics Targers ]
2 ¥ Submission Input and Qu _ =
4Period: YearTorall 4 Vear 2014 =]
B B Input and Resuhs - =
¥ Schedule 1.1 - Contractual Se| " 2 - 4
Schedle 1.2 - Othar Servioe Targel) | | 5 vi= Agresments {{Tatall{ Recondiiation | Notes 5
. o 3
Schadule 2.1 - Staffing (Direct Dl Financal Swiement Foll =
Schedle 2.2 - Staffing (Chid Care Avg Monthhy Number of Chidren Served o vfll 3
i ” 5 G ual Service heduldl] '
5 Sy 13- Afjndont i G Infants | Toddbers| Presthoolers | [ Si | Up to and Inchuding SK | School Aged | Recreation| Informal | 5 Gontracny Targers Envolment g
Cohatin 24 - Bcparad Bt | |SUPPORTED WATH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY e
Schedle 26 - Miscelaneows SOUTENU PAR DU FINANCEMENT PROV, ET LA PART MUNI, DES COUTS REQUISE SEULEMENT
Schedule 2.7 - THOMO Reimbursef | |-
Schadul 2.6 - Capadiny Funding to ] | | Fee Subsidy 2 % P £ 1 174.32 | No [ Nan
Schedule 3.0 - Allocations for Operlf | | Servioe Tamet 1 2 pi] 50 1 17433
Schedule 3,1 - Entlement .
 Sehedule 4.0 - Misgation Funding ‘Special Nesds Resourcing 30 1 3 |Yes/ Oui
Schedule 4.1 - Capital Cary Forwalll | | Service Target 2 30 1 3
Data Anshyss and Review a
Guideline Adherence Canfirmsen | | | Onear werks nd LEAR - Formal s 1 2|10 3 £} 78| No [ Nen
Ontarko Works and LEAP - Informal s 5|No  Nen
Total Service Target 3 ] 11 2|10 3 i} H ]
B 9 Wamings
B Erors
» COMPLETE WARIANCE REPORT IF ANY W ARIANCE CHECK FAILED
el REMPLIR LE RARPORT DES ECARTS EN CAS D'ECHEC DE VERIFICATION DES ECARTS
5 B valdation Formars
@ B Soumission Entrée et requite
¥ gubmission Mansgement - Madifier_Gestion

To see the Validation Error the user can click on Data Validation Message to displays
the error message.
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i Forms [ Task List Status.
e Task - Schedule 1.1 - Contractual Service Targets-Schedule 1.1_F§ - Tas Instuctions
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& P Submission nd Quany Period: VearTotll H
= B tnput 2nd Resu #openedt %
“¥ Schedule 1.1 - Contractual Se| I~ [Red ~ & 3
59 S 12 . Orber Service Targel] | | Servee Agreemants [ Totall Raconchaton | otes B
9 Schedule 2.1 - Direct Deliy Financial Statements =
& 9 Schedule 2.2 - Staffing (Chi Care Awg Monthly Number of Ghildren Served E
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@ & Variance Reporc ‘Onario Wiorks and LEAP - Informsl s 5| No/ Nn
2 B erors and warnings Total Service Target 3 9 1 20| 3 13 5 8
& ™ Wamings |
@ Enos (COMPLETE VARIANCE REPORT IF ANY VARIANCE CHECK FATLED
REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECHEC DE VERIFICATION DES ECARTS.
In order to correct the error, the user enters the correct value and saves the data. The
confirmation message that the data is saved successfully is shown and if the data is
now correct the validation message on the right side of the form disappears.
ORACLE Emerprise Fusion Edition S TRAIN MALLCOM | Help | Log OF

& Forms Task List Status I
My Task List Task - Schedule 1.1 - Contractual Service Targets-Schedule 1.1_FS  Tssk Instuctons
5 B Submission Input and Query - missio
B '5:" — ] Qo R = Schedule 1.1 - Gontractual Service Targets
8 P submission 1
P 4 Perod: YesrTorlt Pl = ¥ Vaar: 2014 _
- [k -
p— - Messages for this page are listed
Service Agreemens | Total | Recons belave,
(@ The dat= has besn saved Financial Grzezments Finandbl
[| @ Role was run successfully Avg Monthhy Number of Chidren Served Did Varifped
™ I ing SK | School Aged | Recreation | Informal | = Contractual rice Targets Envolment hedule 1|
L ‘SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY i
CL 'SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNI. DES COUTS REQUISE SEULEMENT
B ¥ Schedule 2.7 - TWOMO Reimburses =
B ¥ Schedule 2.8 - Capacity Funding 1o | | Fee Subsidy 12 614 20 ] 1 202 Mo/ Non
1 9 Schedule 3.0 - Allocations for Operaff | [ Service Target 1 2 Es Tr2s 20 £ 1 m
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¥ Schedule 4.1 - Capital Camy Forwafll | | Service Target 2 30 1 31
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R b | |-ontano werks and 1EAP - Formal s 1 32| 3 3 78| No f Non
B¥ ‘Ontario Works and LEAP - Informal 3 | No/ Non
] Total Service Target 3 £} 1 32(10] 3 13 5 8
@Y o 'COMPLETE VARIANCE REPORT IF ANY VARIANCE CHECK FAILED
REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECHEC DE VERIFICATION DES ECARTS

If the user is not sure what the cell format should be different, the user can check the
cell format by opening the same form in the Validation Formats folder and see the
description for each cell.
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o B Avg Monchly Mumber of Chikien Served
- Infants Toddlrs Preschoolers x K Up 10 and Including SK Scho
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If the user enters a non numeric value into a cell that is expecting numeric values an
error will be dislpayed and the user will not be able to navigate away from that cell until
it is corrected.
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5.2 Cell Right Click Functionality

Hyperion Planning provides additional functionality to support data input. This
functionality can be accessed by right clicking on an input cell. Functionality that is
available in EFIS 2.0 includes:

e Edit
o Cut
o Copy

o Paste
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o Clear

5.2.1 Edit

Comments
Supporting Details

Show Change History

Standard Cut, Copy, Paste, Clear functionality can be accessed by right clicking on a
cell the select Edit > Cut will delete the value and save it to your clipboard, copy will
copy the value to your clipboard, paste will copy in the value from the clipboard and

Clear will delete the value in the cell.
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5.2.2 Comments

Users can attach a comment to a cell by right clicking on the cell and selecting
Comment.

ORACLE Enterprise Performance Management System Workspace, Fusion Edition
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In the comment box that is displayed select either the green + or Action 2 Add to enter
a comment

Comments | = W}

#; Period: YearTotall ¥ Wear: 2014 o5, Recipient [, Version: Recipient Working Version
Category: Fee Subsidy, Scenario: Financizl Statements, Account: Awvg Monthhy Mumber of Children Served, SubCategony: SK [ ]

L A=

Help Closa

When the Comments window opens enter the comment and select Add.
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Type comment hers and s= tdd

Apphy to all selected cells D

Help Close

Comments are saved with the user name and date. Comments cannot be edited once
they have been saved.

Comments
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1 | Comment Lisar Diate
4 | Type comment here and select Add EFIS. TRAIMERDLZ| 2015/02/11
3
|
i
g
3
Help Close

To remove a comment, select the comment then either the Red X or Action = Delete
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B ¥ Schedule 3.0 - Allocations for Oper: Service Target 1 12 EL] 61 24| 20 s0 1 202
5 9 Sehedule 3.1 - Entitlement
1 ¥ Sehedule 4.0 - Misgation Funding. ‘Special Needs Resourcing n i 3| Yes ) Oui
@ ¥ Schedule 4.1 - Capital Camy Forw Service Target 2 E' 1 3
9 Dats Anabysis and Review
8 5 Guidsline Adherence Confirmation Onearis Works and LEAP - Formal £} 1 32|10] 3 13 78| No / Non H
@ 9 varisnce Repore Onaris Viorks and LEAP - Informal 5 5 No Non
" ¥ ermors and warings Total Service Taget 3 £} i 32|10 3 13 5 )
& P Reports
& vaidaien S COMPLETE VARIANCE REPORT IF ANY VARIANGE CHECK FAILED
3 ¥ Soumission- Enrde &t requéte REMPLIR LE RAPPORT DES ECARTS EN CAS DECHEC DE VERIFICATION DES ECARTS

2 ¥ submission Management - Mosifier_Gestion
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5.2.3 Supporting Details

The user can add supporting details to an input cell by right clicking on the cell and
selecting Supporting Detail.

ORACLE’ Enterprise Perf: nce Management System Workspace, Fusion Edition ogged in 25 EFIS. TRAINEROI@GMAILCOM | Help | Log OFf

& Forms Task List Status
11 i gets TIPS Tack Instructions
5 Sehedule 1.1 - Contracruzl Service Targets
1 Period: YearTorall 4 Yean 2014
P |+ [Recipient Working Version _r
= ¥ Schedule 1.1 - Contractual Se e =
& ohedule 1.2 - Other Service Ta Service Agreements [ Tatal ) Reconciiaton | Notes
@ 9 schedule 2.1 - 51 Financal Statements Financial
B & Scheduie 2.2 - S Avg Monthly Number of Chikren Served Did Variz
AW Infants | Toddlers | Preschoolers | 2K 5K Up 1o and Inchuding 5K| School Aged | Recreation | Informal | = Contractual Service Targets Envolment Grouss | Schedule L1
1 9 cohetui 2.6 - rojeced Expancinel] | [SUPPORTED WATH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY
@ & Scheduie 2.6 - M SOUTENU PAR DU FINANCEMENT PROV, ET LA PART MUNL, DES COUTS REQUISE SEULEMENT
8 9 schedule 2.7 - TW =
& Schedule 2.8 - Cspacty Fund Fes Subsidy S u 6124 20 £ —m " 202| No | Nan
H ¥ Schedule 3.0 - Allocations for Oper: Service Target 1 £ 61 24| 20 50 Adjust 202
a -
@ 9 schedule 3.1 - Env I
& Schedule 4.0 - Mit Special Needs Resourcing E' 1 e 31| ves/ Oui
B 9 Schedule 4.1 - Ca Saryios Targer 2 n 1 .é =l 3
8 5 Dats Anzhysis = . S g ks
Documan: Attachmants
0 L | | ntario wierks and LEAP - Formal s 1 2w 3 13 ;: "”am :ls'"e 78| No / Nen
Ontario Works and LEAP - Informal . l“::"“ e 5| No/Non
Select Al

Total Service Target 3 2 1 210 3 o =

COMPLETE W ARIANCE REPORT IF ANY VARIANCE CHECK FAILED

REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECHEC DE VERIFICATION DES ECARTS

To enter data select Action = Add Child or Add Sibling depending on how the user
wants to display the information.

Supporting Detail [

| | ) Category: Fee Subsidy | iy Period: YesrTotall | ¥ Yearn 2014 | o Recipient: [, Version: Recipient Working Version

3 WO | Deach | E

Help || Refresh || Sawve || Cancel

The example below shows how the user can provide the detailed split between A and B.
Enter the detailed amounts and labels and select Save.
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Supporting Detail |

W Category: Fee Subsidy i, Period: YearTotall ﬂ‘l’ex 2014 :".",R:Bc'lp'lem: Algoma DSAB Version: Recipient Working Version

=R

Action - View-|dkahxﬁ¢1§f\ & 71 | B Detach |

Financizl Statemeant
Lzbel Chperator Awvg Monthhy Numb
Reorestion

A +
[ E +
l&2] Tatal 5.0

2
3

1]

Help Refresh || Sawve || Cancel

The total of the supporting details will be calculated and stored in the cell. The colour of
the cell will change to dark blue to indicate that there is supporting detail

ORACLE' Enterprise System Worksi Fusion Edition

L

M2014FIS - Task List Status X

Bl Forms [ Task List Status

o Lt Task - Schedule 1.1 - Contractual Service Targets-Schedule 1.1_FS - Task Instuctors
= B Submission Input and Query - FS._ Soumissio
2 ® submission Input and Query

= Schedule 1.1 - Conractual Service Targets

X 4 Periodh YearTorall 4 Year 2014
& B Input and Resuks
1 ¥ Schedule 1.1 —r Red g Ve -2
B Scheduie 1.2 - ‘Service Agreements | Total | Recondiiston | Notes
9 Schedule 2.1 - Stal Financial Statements Financial
1 Schedule 2.2 - St Avg Manthty Number of Chidren Served Did varinc]
o Infants [ Todders | Preschoolers | 1| 5k [ Up to and Inchuding Sik | Sehool Aged | Recreation | Informal | = Gentractual Sesvice Targes Envolment hedule 1.1
& & chedle 2.4 - wITH FUNDING AND REQ) SHARE ONLY
& & Schedule 2. SGUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNL. DES COLTS REQUISE SEULEMENT
& 9 Schedule 2.7 - TWOMO Reimbursefl | |-
1 9 Schedule 2.8 - Capaciy Funding o ] | | Fee Subsily. 2 om €1 (24| 20 E | s/| 206| Na / ton
5 9 Schedule 3.0 - Allocatins for Operall | | Service Targec L 12 S 61[24] 20 s 206
B & Schedule 3.1 - Endement .
B chedule 4.0 - Mitigacion Funding ‘Spacial Nesds Resourcing 2 1 31 | Yes / Oui.
1 ™ Schedule 4.1 - Capital Camy Forwalll | | Service Targes 2 30 1 31
1 9 Data Anslysis and Review :
1 ™ Guidsiine Acherence Confrmation |l | | Gnearis ierks snd LEAP - Formal s 1 3z{10| 3 13 78| No / Non E
¥ variance Report Ontzrio Works 2nd LEAP - Informsl s 5| Mo/ Non
@ B Emors and T s 1u 2|10| 3 13 5 ]
& 8 fepors .
B valisuan Fomass ‘COMPLETE VARIANCE REPORT IF ANY VARIANCE CHECK FAILED

3 P Soumission- Entrée o requite

REMPLIR LE RAPPORT DES ECARTS EN CAS D'EGHEG DE VERIFICATION DES ECARTS.

5 ¥ Submission Manzgemen: - Modier Gestion
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5.2.4 Show Change History

Each time the value in a cell is changed a record on the changes is kept in the
database. To access the list of changes right clicking on the cell and selecting Show
Change History,

Task List Status

141 *¥ Schedule 1.1 -

14 LAF5){ Task Instructions

= Schedule 1.1 - Convactual Service Tangets
4 Pesod: YearTormil

+ [Resipient -3

B ¥ Schedule 1.2 - Other Service Targ

1  Schedule 2.1 - Staffng (1
1 9 Schaduls 2.2 - Staffng (s
1 Schaduls 2.3 - Adusted Gross Expg
[ Sehedule 2.4 - Projected Expendinu

5 W Schedule 2.6 - Misceliznecus

1 Schedule 2.7 - THGMO Reimburse
B 9 Schedule 2.8 - Capacity Fundi
H ' Schedule 3.0 - Allocations for Oper:
B Schedule 3.1

Care

ing 10

Servie Agreements [ Totali Reconciiaton | Hores

#vean 2014

Financial Swemens Financial
Avg Monthty Number of Chikiren Served Did Variand
Infans | Toddlers | Preschookers [ 3K [ 5K | Up 10 and Inchuding 5K | School Aged | Recreation | Informal | £ Contracwal Service Targets Enrolment Schedule 1.1
‘SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY
'SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNI DES COUTS REQUISE SEULEMENT
Fee Subsidy 12 k2] = 5 5 206| Na / ton
Service Tanger 1 2 £ adst 50 s 205
- | Commens
‘Special Needs Resourcing B i s Bo 1 31| Yes / Oui
Sarvice Targat 2 == - 80 1 "
(6] Show Changs Hiswory:
7 Doaument Attschmants L
n |4 | | ortario Werks and LEAR - Formal s 1 ‘B 13 78| No/ Nen E
Ontario Werks and LEAP - Informal | e B 5| N/ Non
Totzl Servie Targer 3 f] 1 - 13 H 8
COMPLETE VARIANCE REPORT IF ANY \ARIANCE CHECK FAILED
REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECHEC DE VERIFICATION DES ECARTS

The Change History screen will be displayed and identifies that user, the date, and the
values that were changed.

| Change History

User [zt Old Walue Mew Vahe
EFIS. TRAIMERD1E 2015/02/06 10:4D A Fmissing 3.0
EFIS, TRAINERD1E 2015/02/0% 3143 Pk 333.33333 550
EFIS. TRAINERDLE 2015/02/11 11:3% A 54.0 &1.0
EFIS. TRAINERDLE 2005/02/11 11:41 A&L.D 33.3333
EFIS. TRAINERDLE 2015/02/11 11:44 4 33,3333 &61.0
EFIS. TRAINERD1E 2015/02/10 9:27 AN S50 4.0
EFIS. TRAINERDLE 2015/02/10 9:28 ANS4.0 550
EFIS. TRAINERD1E 201502005 3:38 PN 53.0 E5.0
EFIS. TRAINERD1E 2015020059 3:40 PN 55.0 333.33333
EFIS. TRAINERD1E 2015/02/10 9:28 AN 55.0 4.0
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5.3 Reports

Reports provide the user with the results of each of the sections in a report format.
Users can access individual reports or a Report book that contains all reports.

s EFIS. TRAINEROI@GMAIL.COM | Help | Log Off O

Task List Status

Task - Reports | Task Insuctons

Stats Incomplece
Complted Date

Complete No

Due Date

5.3.1 Running a Report

To run a report the user selects the report from the Task List..

& Forms Task List Status
& Manage Task Lists Task - Schedule 1.1 - ioe Targel X Task Instructon:
) T“kfm Status Incomplete
' 1nput and Resuits a Campleted Date
B P reports A Complete No
¥ Certificate Due Date

= ¥ schedule 1.1 - Contractual Service | _

' /Schedule 1.1 - 1

 Scheduie 1.2 - Other Service Targe
B Scheduie 2.1 - Staffing (Direct Deliv
P schecule 2.2 - Staffing (chid Care,
B scheduie
¥ scheduie

- Projected Expendity
< n, ] G
-

Business Rule Security
e Complete [ | Previous Incomplete  Previous | NextIncomplete = Next | Task List Home

The Preview User Point of View screen will be displayed. The first time reports are run
each cycle the user must select a version and the Recipient name. This will become the
default setting until the user changes the Version. If an error message is displayed
prior to the POV screen check that the settings in Section 3.1 have been applied
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Preview User Point of View

(]

This report/book will run for the members on the user point of view listed
below,

Version
Version
Recipient

Redpient

(]

Edit Member Names

To select the Version click the Select button beside Version to open the version

selection screen, select the version then OK

Help oK | Cancel
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Preview User Point of View

Find: | yame IE' * 2 IilUsv.=_~ wildcards
ﬁ‘" | |‘|‘|F‘.ows Per Page: | 20 |E|
Mame Default

S @ Version

® . .
EHS ™ submission Versions

Recipient Waorking Version

Reapient Dra

Wi - vaooot

-8 © v10002 Recipient Draft 2

gy ® V10003 Redpient Draft 3

-8 © vio004 Redpient Draft 4

-8 © yiooos Recipient Draft 5

gy ® V10006 Redipient Draft &

-8 © v10007 Blank Template For Reset
gy & V10ROV Redpient FA Viewable Version

Q,I & V10FOVDO1 Recipient FA Viewable Draft Version 1

@J & V10FOVDOZ Fedpient FA Viewable Draft Version 2

QJ & V10FOVDO3 Redipient FA Viewable Draft Version 3

To select the Recipient click the Select button beside Recipient to open the Recipient
selection screen, select the Recipient then OK



Preview User Paint of View e

Membess

Avalable: Recpent (12 o 2]

Findt [ame = # 9 o vieares
o' | &S [Rows Per Page: |20 [o]

Name | Dafaule

91 movoos inas

* ' Substitution Varizhles |

o
The POV screen is will now have a version and the Recipient selected select OK to run
the report
Preview User Point of View |=
Thits report/book will run for the members on the wser point of view
listed below,
Wersion
Recipient Working Ves | Select...
Recipient
DSAB Select...

D Edit Member Names

| Help - Caneel

The report will generate in PDF. The user can view, save or print. Reports will contain
detail similar to the reports that were available in EFIS 1.0
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@ Error executing query: Y ou are trving to open the
form, but cannot becanse one of the required
dimensions is not present in the Page. Possible causes
may be that vou do not have access to at least one
member of a required dimension, or the member
selection resulted in no members present. Contact yvour
administrator. Dimension(Version)

com. hvperion planning. NotEnoughA ccessException

Cancel

a Submission Version: Recipient Workina Versinn
Recipient Name: .

H Year: 2014

ntarlo Cycle: Financial Statements

Schedule 1.1 - Contractual Service Targets - Service Agreements
Supported with Provincial Funding and Required Cost Share Only

Service Agreements - Avg Monthly Number of Children Served

Infants Toddlers|  Preschoolers K SK Up to and School Aged Recreation Informal Total

Including 5K

Col. 1 Col. 2 Col.2 Col. 4 Col. & Col. & Col. 7 Col. 8 Col. & Col. 10
Service Target 1
Fea Subsidy 14.0 320 58.0 230 200 - 450 0.0 -1 1920
Service Target 2
Special Meeds Resourcing - - - - - 250 20 - - o
Service Target 3
‘Ontaric Works and LEAP - Formal 10.0 10.0 20 10.0 a0 - 130 E - 780
COntario Works and LEAF - Informal -1 - - - -1 - - - 50 5.0
Total Service Target 2 10.0 10.0 320 1I1EI—| a0 - 120 R 50 830
Contractual Service Targets - Motes Test

To change the Version selection without regenerating the report the user can select the
Version screen by selecting the Version tab in the top left side of the report Select the
new version then select OK and the report will refresh with the new data.

= Preview User Point of View £
AL OIS CommonEbiSdhedule 154 ) i
Version: Redpient Working Version | Fecipient: Algoma DSAB Avaliable: Version (1-20 of 32)
1 Find: [uame = - P
ﬁ“ | I‘ L‘ ‘Rows Per Page: | 20 lz‘
Name Default

B ™ version

S ™ submission Versions

P EEY Redpient Versions

'@J @ V10w Recipient Working Version
@J 10001 Recipient Draft 1
'\‘)J ) 10002 Recipient Draft 2
iy ¢ B Ty Redpient Draft 3
gy | 5} V10004 Redipient Draft 4
P @ Recinient Nraft § i
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5.3.2 Generating Report Books

To generate a complete set of reports for all forms the user selects Reports - Report
Book

@ W Schedule 27 - TWOMO
1 9 Schedule 28 - Capacy
¥ sehedule 3.0 A

The Preview User Point of View dialog will appear. Select the Version that is to be run
and then select OK to generate the Report Book.

Preview User Point of View

£

This report/bock will run for the members on the wser point of view
listed below,

Diatzbhase Connection
M2014FIS_Planning_Main

ersion
Recipient Working Ve | Select...
Recipient

ISAB Selact...

|:| Edit Membear Mames

Help OK Cancal

The report will return the Table of Contents;

the user can open a single report by

selecting the ICON to the left of the report or open the complete report by selecting File

- Open In 2 Complete Book in PDF
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ORACLE enterprise Fusion Edition

IM2014FIS/F5/2014 CMSM and DSSAB Submission - Financial Statements.
Version: Recipient Working Version | Resipient: DSAB
@ Book Table of Coments: 2014 CMSM and DSSAB Submission - Financial Ststements
Name Member Sakection
Certificate
hetule nEacial Service Targets - Service Acreoments
el nscryal Sarvice Tarmes
hedule 1,3 ~ Other Service Tarets
hedule 2.1 - Staffing DmD&fvavaavm
hechsle 2.3 - Staffing (Chid Care
hechile 2.3 - Adjusted Gross Expandituras
hecile 2.4 - Projected Expanditures
hecule 2.6 - Miscellansous.
hecule 2.7 - TWOMO. for DSSABs)
hedule 3.6 - Capacey Funding i Support 7
[Schashle 3.0 - Allocztons for Operating and Other Purposes
[ochede 31 Enelement - Enexlemere Callacon
hedule 3,1 _ Enetlemant _ Adusy o 15/ En
hedule 3.1 - Enctlemant - Transfer Payment Summan 15/ En
hedule 3.1 - Enttlement - Capical IS/ EN
hedule 3.1 - Enttlement - for Urilzation IS/ EN
Mitigation Funding IS/ EN
hedule 4.1 - Capital Forward IS/ EN
Yata Analysis and Review IS/ EN
arisnce Report EN
Erors EN
Jsrrings EN

ORACLE Enrarprise parformance Management Systam Workspace, Fusion Edtion

Ext
4 ook T O COWETSTI0NS CMSM and DSSAB Submission - Fnancial Statements
Name Member Seiscton Report Location
Certicate 1201 EN
hefik 1:1.- Cenkanieal Sevies Taresss - Senvise AsmeTens EN
hesule ntrachual Servios Targets EN
hedule 1.2 - Orher Service Tames 1201 EN
- Staffing (Direct Delvery of Serviees) 12014FISC EN
~Staffing (Chid Care 1201 EN
- Adhsiad Gross Expencires 1201 EN
hedyle 2.4 - Projected Prpenditures 1201 EN
hedule 2.6 - Miscallancous EN
heduke 2.7 TWOMO Rl for DSEAES) 12014F1S/Commen/EN
hedule 78 Capachy Furding to Supper: 12014F1S/FS/EN
B tng and Other Purposes 12014F1 EN
Jament - Entilemant Caluaton
Jement - Adjusment for 1201 EN
Jament - Transfer Paymens Semmany EN
Joment - Breakdovn of Captal 1201 EN
< Erttlement - Usization 1201 EN
Misgation Funding 1201 EN
Schedule 2.1 Capital Carry Forward
Cata Analyss and Review 1201 EN
ariance Report 12014FIS/CommenEN
Errors 12014FIS/Comman/EN
jerings 1201 EN

Report will be generated in PDF.

ORACLE' enterprise System Worksy Fusion Edition

‘ E Sign Comment

=P 2014 CMSMand

& DSSAB

Submission -

& Financial Table of Contents

Statements =
[F Table of

Contents 2014 CMSM and DSSAB Submission - Financial Statements

I Certificate

IF schedule 1.1 -
ggr'\‘fl';ﬁ”;'gm Certificate. . i e 1
. Schedule 1.1 - Contractual Service Targets - Service Agreements
Agreements Schedule 1.1 - Contractual Service Targets

[T Schedule 1.1 - Schedule 1.2 - Other Service Targets...
Contractual Schedule 2.1 - Staffing (Direct Dehvezy of 'Senlces) ....................................................................................... 5
ST Schedule 2.2 - Staffing (Child Care AQMIMISTATON). ......crveieieeieeceeieeeeseeeeeeee e sseesesn s eseeneeen 6

P cobrtian 10
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5.3.3 Opening a report in Excel

Reports that have been generated in PDF can also be exported and saved in Excel
format. To export a report to Excel select File 2 Export > Excel

g: & | Eile View Favorites Tools Help

Open 4
Open In 4

Close

Export
Preferences. ..

PowerPoint

Log Off
Exit

B> Ontario

Schedule 1.1 - Contractual Service Targets
Supported with Provincial Funding and Required Cost S|

#wg Monihiy Number of Ghildren Served
Incants] Tooderz| Freschociers) ] ax] Upwand| =chociAged]  mecreal
Inciucing 2x|
| cal 1] caLz| cal 3| cal 4| Zal 5| ca 8| ol 7| e

Select Open with or Save

- Opening Schedule 1

You have chosen to open:

& Schedule 1_1.xls
which is & Microsoft Excel 97-2003 Worksheet

from: https://test.efisfma.csc.gov.on.ca

What should Firefox do with this file?

Microsoft Excel (default) -

i) Sawe File

[7] Do this automatically for files like this from now on.

[ QK J| Cancel |

L

Report will be exported to Excel
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|
¥ = 2 Schedule1_1 [Read-Only] - Microsoft Excel = =
m Home | Insert  Pagelayout  Formulas  Data  Review  View  Developer  Smart View o @ =@ B
== M cut e . = = ) . Fem Tk PR E Autosum A 2
Bl s Calibri » S Wrap Text General Eug g B ™ e = Z? j‘-}
Faste Iu- B Merge & Center| - ~ 9% s | <2 %  Condtional Format Cell | Insert Delete Format Sort & Find &
- < Format Painter = e 5% W0 >0 | g matting ~ as Table ~ Styles~ |+ - &2 Clear - Filter = Select~
Clipboard Font Alignment Number Styl Editing
Al - b3 -
A B @ D E F G H 1 J K L M 5
My
i > Submission Version: Recipient Working Version
2 L Recipient Name: DSAB
./~ Ontario
a Cycle: Financial Statements
5 = |
6
7 .
s Schedule 1.1 - Contractual Service Targets
9 Supported with Provincial Funding and Required Cost Share Only
10
11
12 Page:Recipient Working Version, Alzoma DSAB
13 [Avg Manthly Humber of Children served
14 Infants] Toddlers]  Freschoolers] G| SK] Up to and Including SK] School Aged] Recreation] informa]  Total] Did Variance Check Fai)
15 Col 1 Col. 2| Col 3| Col 4] Col 5| Col g Col 7| Col 8] Col 9| Col. 10] (Note 1)
16
17 [Service Target 1
18 [Fee Subsidy 12.0] 34.1] 61.0 24.0) 20.0 0.0 50.0) 50| 00| 2060 o / Non)
19
20 [Service Target 2
21 [Special Needs Resourcing 0.0] 0.0) [ 0.0) [ 30.0] 1.0} 00| oo st0 Ves / Oul
22
23 [Service Target 3.
24 [Ontario Works and LEAP - Formal 5] 11| 32.0] 10.0] 3.0} 0.0) 13.0] 00| oo 780 Ho / Non
25 [Ontario Works and LEAP - Informal 0.0] 0.0) [ 0.0) 0.0 0.0 0.0 0.0 50 50 Ho / Non
26 |Total Service Target 3 5.0) 1.0 320 10.0 3.0 0.0 13.0 0.0  so 30 0.0 A
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6 Smart View

6.1 Smart View User Set Up

The Smart View is an Excel add-on that allows user to enter data into EFIS 2.0. Web
forms or Smart view have same functionality. In order to use Smart View (add-in for
Oracle Hyperion EPM products), the add-in needs to be installed on users workstation.
Please refer to EFIS 2.0 — User Set Up Guide for detailed instructions.

6.1.1 Setting up the Connection

In Smart View, go to Options, Click on Advanced and specify the shared Connections
URL the select OK

https://efis.fma.csc.gov.on.ca/workspace/SmartViewProviders

E-I‘ [~ I= Bookl - Microsoft Excel

Home Insert Page Layout Formulas Data Review View QuickBooks
3 ) unde By copy @ @ = P Hen-
¥

S @ Re Paste

Panel | Connections

i

Sheet Info

Refresh | Submit
- \F;]] Functions = - Data Mare
Start Edit Data neral
Al - b3
| Options 2 L
A B - D

1 Member Options H S& Change global Smart View options. pi-
z Lo

Data Options 7
3 General (i)
: 0> e e o on cahepacston: -
£ Formatting AN O T A
6 Number of Most Recently Used items
7 Cell Styles
: [ Delete All MRU Ttems )
5 Extensions Logging (i)
10 Log Message Display [Errors v]
11 ["IRoute Messages to File | i3 ‘-J.Isers*]vlanageﬂm-"-F\DDData'-Rnammg'-,oracls‘-Sm.‘
12 Clear Log File on Next Launch
L Display 1) |2
14
15 Language [Engllsh v]
16 [ Display Smart View Shortcut Menus Only
17 [ Disable Smart View in Qutloak
18 Enable Ribbon Context Changing
19 Disable options that are not valid for the active connection
20 [ Display Drill-Through Repart ToolTips
zl [ show Progress Information After (seconds) l:l:l
22 —

Compatibility (i)

23 -
24 Reduce Excel File Size
25 D Improve Metadata storage
26 [CIRefresh selected Functions and their dependents
= Mode o)
28
s o o=
30
21
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https://efis.fma.csc.gov.on.ca/workspace/SmartViewProviders

6.1.2 Setting up Smart View Options
6.1.2.1 Data Options
In Smart View, go to Options, Click on Data Options. Check to make sure that no

boxes are checked, clear the #NoData/Missing Label: to be blank, select the arrow on
the right of the OK button and select Save as Default Options

Member Options E H Change Smart View options related to grid rows and columns.

Data Options

Suppress Rows
Advanced [IMe Data / Missing

Formatting [zero
|:| Mo Access

[Cinvalid

Extensions [[]Underscore Characters
[“1Repeated Members
Suppress Columns
[CIno Data / Missing
zere @

[Ino Access (t)

Cell Styles

Replacement

#MoDataMissing Label:

|
#NoAcress Label: : —
|

#Invalid/Meaningless: #Invalid

Submit zero
[ pisplay Invalid Data
[C1Enable Esshase Farmat String
Maode

Cell Display
[IMavigate without Data

["]5uppress Missing blodks

| | Reset |

Save as Default Options
Apply to All Sheets
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6.1.2.2 Member Options

To retain formulas that have been added to a Smart View form when moving between

versions, it is recommended that the Preserve Formula on POV Change is checked

Options 1] u ‘
Member Options t—uﬂ Change member and dimension options on the grid.
Data Options E— (i)
Advanced Zoom In Level [Next Level VI
Formatting Member Mame Display [Member Name Only VI
Indentation [Subitems hd l
Cell Styles
Ancestor Position [TOIJ ']
Extensions Member Retention (i)
Incude Selection
[ within Selected Group
[ Remove Unselected Groups
Comments and Formulas 'i'
Preserve Formulas and Comments in ad hoc operations (except pivot)
[ Farmula Fil
[~ Enable Enhanced Comment Handling
Preserve Formula on POV Change
Help ] [ Reset K 'l [ Cancel
=}
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6.1.2.3 Formatting

In order to format columns and rows user needs to set the formatting as per below
example

r
Options L] u
Member Options 13— Change grid formatting, styling and coloring options.
Data Options ) —
Formatting W)
Advanced [ Use Thousands Separator
Formatting I @ Use Cell Styles
() Use Excel Formatting
Cell Styles
Move Formatting on Operations
Extensions [C] Retain Numeric Formatting
Adjust Column width
Scale [Default - ]
Preview | |
Decimal Places [Default v]
Preview | |
[ Help ] [ Reset l [ 0K 'l [ Cancel
= &

Select the arrow on the right of the OK button and select Save as Default Options.
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6.1.3 Connecting Smart View to Database

To access forms in the Smart View open a new session of Excel and click on Smart
View tab. Select Panel and Shared Connections. The Go Secure Login screen will be

displayed, enter your user name and password and select Sign In.

Home  Inset  Pagelayout  Formulas  Data  Review  View QuickBooks a@ =@ =
- 1) undo B Copy @)@ @ 8= Trew-
= @ Redo | [ Paste U= & sheetInfo
Connections Refresh | Submit | Options
S Functions = S Data Bl More -
tart Edit Data General
Al - F3 \ -
| =
=
=T
A B € D E r ~ | Smart View v %
1 k Login == M
5 ] Smart View Home: @ - »
3 7
% Shared Connections
4 ny) Connections from shared repository
5 tk -
5 Ontal'IO & Private Connections
Locally defined connections and shortouts to
7 shared connections
8
5 Recently Used
10 B Task List
@ Submission Input and Query =
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12 TRAINZ
13
( ®SECURE B Task List
14 S Submission Input and Query o
15 GO Secure ID cscvigdeapwigO5.service. chs.gov.on.ca |
16 - 4 TRAINZ
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1 — e
19 GO Secure Profile CsCvigacapwig0s,service, cins.gov.on.ca
See your profile ge your password or security questiol .
o See your profile, change your password or security questions
21 [ Task List
5 i Administraton =
22 Forgot your ID or password? cscvigdcapwighd.service.chs.gov.on.ca |
< ] v S1319E2C
23
o
2
26
27
“ Home  Insert  Pagelayout  Formulas  Data  Review  View | SmartView | QuickBooks a@ =B R
5 nda | B2 0= 2 Hep~
:'. ~3 £ Und Cuuy @ @ gz ¥ Help
- @ Redo Paste = (& SheetInfo
Panel | Connections Refresh | Submit | Options
5 Functions ~ E More -
Start Edit Data General
AL - A -
| =
-
=T
A B c D 3 F G H 1 1 K N P = | Smart View v %
. =
> Shared Connections o v »
3 Select Server to proceed - -
4
5
6
7
8
3
10
1
12
13
14
15

To navigate to the Task List to access forms select Oracle Hyperion Planning Fusion
Edition from the Shared Connections drop down list
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= s
PAGE LAYOUT
Copy
Paste
Functions ~
Edit

FORMULAS ~ DATA  REVIEW  VIEW | SMARTVIEW
o=
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® 8 £

Refresh  Submit  Options
Data
Data

P Help -
(" Sheet Info
= More~

) Undo
@ Redo

Start General

Al M *

Book! - Excel 72 @ - x
QuickBooks Signin
“
K L M N 0 P Q R S T[~
Smart View X
Shared Connections @ o

Select Server to proceed
Orade® Essbase

Orade® Hyperion Planring, Fusion Ediion
Reporting and Analysis Framenork.

M o-————+ 100%
ENG  201PM
US| 2014-03-28

< 8wl & W

Expand the Database, expand the Application to access, expand the Task List, and
then double click on the Task List to display tasks

AO:@!

“Hnme Insert Page Layout Formulas Data Review View Developer Smart View
% w3 @ 8 &I
¥ =
g U= & sheetinfo
Panel | Connections Refresh | Submit  Options
B Functions ~ > Data B More -
Start Edit Data General
\ AL - | 5
\ \ E
A B T D E F G H 1 J K L M N o] P a | Srmart View v x
] E
5 ] Shared Connections @ o »
& Orade® Hyperion Fianning, Fusion Edition v =~
a
5 |28 cscvigdeapwig 10, service, cihs. gov.on.ca |
[t~ @ TSIEST3
c £ M2014IS
7 i - Forms
8 i EnE] Tasklisis
9 i LlE] Submission put and Query - FS Sol}
H [=] Submission Management - Modifier_G|
g (- I M2015Ed1
11 o M2D1SEST
12 [l MARDEV
13 @ MCCDEV
@ PI4ISFIS
L (¥ I P1415FSP
15 W S1314E1a
16 = W S131%E2%

The Task List is displayed and forms can be accessed by expanding the Task List.
Reports cannot be run from within Smart View. The user must return the Planning

Application to generate reports.
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8 ] More ~
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=
E
A | B E F G H 1 J K N T Smart View v x
o B
5 | Task List @ o-»
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|| ication; M20 1415
B Submission Input and Query - FS_Soumission-Entr... =
6 =~ O 1.0 Submission Input and Query:
B - O 1.1Input and Results
b O 1.1.15chedule 1.1 - Contractual Service T|
8] © 1.1.2 Schedule 1.2 - Other Service Targets
) + Q) 1.1.3 Schedule 2.1 - Staffing (Direct Delive
10 © 1.1.4 Schedule 2.2 - Staffing (Chid Care A
Tyl © 1.1.5 Schedule 2.3 - Adjusted Gross Expe
=i ~ O 1,16 Scheduie 2.4 - Projected Expenditurs
12 O 1.1.75chedule 2.6 - Miscelaneous
13 © 1.1.3 Schedule 2.7 - TWOMO Reimbursem
14 ~© 1,19 Scheduie 2.8 - Capacity Funding to §
15 © 1.1.10 Schedule 3.0 - Allocations for Oper
= © 1.1.11 Schedule 3.1 - Entitlement
16 = -0 11,12 Schedule 4.0 - Mitigation Funding
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18 © 1.1.14 Data Analysis and Review
Bl ~ O 1,115 Guideine Adherence Confirmation
= © 1.1.16 Variance Report
20 © 1.1.17 Errors and Warnings
21 - O 12Reports
2 - Q 1.3 validation Formats
| © 2.0 Soumission- Entrée et requéte
| |
25
26
27 [ i 3
# View Instructions
29 Task Details A
Edl Task List
e S —
2
33 v | 0EComplete HOverdue
4 4 b M| Sheetl  Sheet? /Sheet3 %3 Ml ur (20|
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6.1.4 Alternative way to open Smart View form via planning application

In the planning application user can open the form directly into the Smart View.

To do so user needs to be in the form that wants to export in the Smart View. Next step
is to click on File = Open in Smart View, or user can click on the toolbar icon for

Fusion Edition

vi Fle E Favagites
4 » TN
# Openin Smart View

H save
= print Task List Status
Preferences... Task - Schedule 1.1 - Contractual Service Targets-Schedule 1.1_FS . Task Insructions
Log Off poumission- Entrée et requéte = Schedule 1.1 - Contractual Service Targets
Exit
5} 4 Period: YearTotall [ Year: 2014
B ® Input and Results
E: - ; I+ | Recipient Working Version ~
Schedule 1.1 - Contractual Service Targets
—
9 Schedule 1.2 - Other Service Targets il oics
B9 Schedule 2.1 - Staffing (Direct Delivery of Services) Financial
B i s Sy (Gl e Ak Service Agreements - Avg Monthly Number of Chidren Serl
& s i ! Infants | Todders | Preschoolers | J | Sk |Up to and Including Sk | School Aged | Recreation | Informal
Schedule 2.3 - Adjusted Gross Expenditures
& s oy SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY
Schedule 2.4 - Projected Expenditures =
Ot i SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNL. DES COOTS REQUISE SEULEMENT
edule 2. - Miscellaneous
9 schedule 2.7 - TWOMO Reimbursement (only relevant for DssABol) | |-
Fee Subsid 14 32 5 23|20 45 0
B9 5chedule 2.8 - Capacity Funding to Support o
Service Target 1 14 32 58|23 |20 45 0
¥ Schedule 3.0 - Allocations for Operating and Other Purposes |4 o
¥ Schedule 3.1 - Entitlement :
9 Sehedule 4.0 - Mitigation Funding goedal HendsResouiing 25 =
& schedule 4.1 - Capital Carry Forward SeceTarget 2, = z
9 Data Analysis and Review :
P — Ontario Works and LEAP - Formal 10 10 32|03 13
& yarince Repart Ontario Warks and LEAP - Informal 5
B Errors and Warnings Total Service Target 3 10 10 52|03 13 5

6.2 Data Input

Select the form rom the Task List and enter data. The system highlights input values in
yellow until they are saved to the database.

m Home  Insert  Pagelayout  Formulas  Data  Review  View  Developer  SmartView  Planning

Bzl Cell Actions + @8 Adjust ~ E] More - BE Approvals

& Lock S, Drill-through &) Copy Version
B calcuiate - [} Submit Data
Ad Hat Data Workflow
POV Schedule 1.1_FS - cscvigdcapwlgl0.service.cihs.gov.on.ca_M2014FIS_2 - x
588 - Recipient Working Version
Dg - £ 61 ~
=
>
A 8 < D E[F G H 1 1 3 Smart View - %
1 Financial Statements
2 Avg Monthly Number of Children Served Task List o »
~Contractua| Service Targets
3 Infants Toddlers Preschoolers JK SK Upto and Including SK School Aged Recreation Informal S 2
4 |SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY cecviadeapulo10.service dhe.oov.on.ca
5 |SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNI. DES COUTS REQUISE SEULEMENT Submission Input and Query -F... ¥
6 v
7 |Fee subsidy 7 50 24 ko] o 50 = G 5O 1.0 Submission Input and Q. +
8 [Service Target 1 1 0 0 50 5 0 B0 LimpdtandResdts
5 E = 2 11 Schedule 1.1
10 | Special Needs Resourcing [) ) o, 020 30 I [ [ : i:xj::: ; i
ﬁ Service Target 2 [] [) o 00 30 1 [} [ popomimiioe)
13 Ontario Works and LEAP - Formal 9 1 3210 3 [ 1 [ [ iz:g:g:::;:
14 | Ontario Works and LEAP - Informal [ 0 000 0 0 0 5 .1‘75d12du|2 2‘5_
i: Total Service Target 3 9 1 3210 3 o 13 o 5| 1.8 Schedule 2.7 | &
17 | COMPLETE VARIANCE REPORT IF ANY VARIANCE CHECK FAILED 'i‘?;g‘d‘Ez:ﬁ:fa
18 | REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECHEC DE VERIFICATION DES ECARTS N R

Select Submit Data icon.
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5 | W P

& Sheet Info
Panel | Connections Refresh Submit | Options

Functions ~ Data
Start Edit ofia General
POV Schedule 1.1_FS - cscvigdcapwlgl0.service.cihs.gov.on.ca_M2014FI5.2 - x
5B+ Redpient Working Version
D8 - £ 60 -
| =
v
=
A B c D E[F G H 1 1 K T smart View - x
1 Financial Statements =
2 Avg Monthly Number of Children Served Task List N - »
~Contractal Service Targets
3 Infants Toddlers Preschoolers JK SK Up to and Including SK School Aged Recreation Informal s
cstvigdeapwia 10.service. cihs.qov.on.ca
4 | SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY ssedadeaps o 10 serice.dhe.ogs.an.c2
5 |SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNL. DES COUTS REQUISE SEULEMENT Submission Input and Query ~F... =
6
7 [reeTunaiay = = a 50 3 & 5O L0 Submission Input and Q1 ~
& |Service Target1 12 3 (i 50 5 0 £ O 1.1Input and Results
5 re O 1.1 5chedule 1.1
10 Special Needs Resourcing 0 0 000 30 1 [ 0 8 i i;i;:g:i ;i
ﬁ Service Target 2 [ [ 00 0 30 1 [} 0 'O 114 5chedde 22
13 Ontario Works and LEAP - Formal s 11 3210 3 [] 1 [ o :__8 i ;::zz:::z ;i
14 |Ontario Works and LEAP - Informal 0 0 00 0 0 ] 0 5 Lo 1 1.7 5chedde 26 4
Jj; Total Senice Target 3 ) 1 3210 3 0 13 o 5 O 1 18 5chedie 2.7 |2
17 COMPLETE VARIANCE REPORT IF ANY VARIANCE CHECK FAILED ) 8 i i?ni;::‘::‘j:;n-
18 | REMPLIR LE RAPPORT DES ECARTS EN CAS D’ECHEC DE VERIFICATION DES ECARTS i
© 1.1.11 Schedule 3.1

To see the saved data in a Web Form, open the same schedule in the Web Form. If the
Web Form is already open select the Refresh button.

ORACLE' Enterpriss Performance Managment System Workspace, Fusion Edition

& Forms Task List Status k
My Task List Task - Schedule 1.1 - Contractual Service Targets-Schedule 1.1_FS  Task Instuctors
put and Query - FS_Soumission- Eniréde et requéte

= ¥ submisson
bmission Input and Cuary
it and Resoks

5 Schedule 1.1 - Contractual Servica Targets

‘ i YearTorall Year: 2014
,Period: i ..

Schedule 1.1 o - LRe fing Ve -
Schedule 1.2 - Other Service Targets Servie Agreements (Tt Reconciiaton | Notes
¥ Schedule 2.1 - Staffing (Direct Delivery of Serv Financial Statements Financial Statemy
(Child Care Administration) Avg Monthty Number of Children Served Did Variance Checl
8 9 Schedule 2.3 - Adjusted Gross Expendinues Infanes| Toddlers| Preschoolers| JK | SK| Up to and Inchuding S School Aged Recrestion | Informal & Gontracrual Service Targets Envolment Grod Schedule 1,1 Varia
8 9 Scheduke 2.4 - Projected Expenditures 'SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONL!

Schedule 2.6 - Miscellaneous

Schedule 2.7 - TWOMO Reimbursement {only relevant for DY | |-
B & Schedule 2.8 - Capacity Funding to Support Transformation Fee Subsidy 12 o 60|+ /20 =0 H 205 | Mo / Non
M 9 Schedule 3.0 - Allocations for Operating and Other Purposes Jl | | Serviee Targee 1 12 3 T4 20 50 5 205
18 9 Schadule 3.1 - Encrlement "

Schedule 4.0 - Mitigation Funding ‘Special Needs Resourcing E 1 31| Yes | Oui
1 9 Schadule 4.1 - Capial Camy Forward Sain Target 2 ) o 2
18 9 Data Anslysis and Review K

Guideline Adherence Confimation | | | oncario werks and LEAP - Formal sl u 2|1 3 1 78| Mo / Non

e e Ontario Works and LEAP - Informal H 5 Mo/ Nen

& P Ervors and Warnings Total Service Target 3 3 i 32/10] 3 ji] 5 8

& P Repons
@ B yaidston Formats

(COMPLETE WARIANCE REPORT IF ANY VARIANCE CHECK FAILED
REMPLIR LE RAPPORT DES EGARTS EN CAS D'ECHEG DE VERIFICATION DES

P Soumission- Enrée et requéte
Submission Mansgement - Modifier_Gestion de |a soumission - Modih

If a user tries to enter data into gray cell following message is displayed:
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Inset  Pagelayout  Formulas  Data  Review  View  Developer | SmartView | Planning
=" Copy ] @ Help -
B @ 3 g
Paste & Sheet Info
Panel | Connections Refresh | Submit | Options
- ) Funetions + - Data
Start Edit Data General
POV Schedule 1.1_FS - escvigdeapwigld.service.cihs.gov.on.ca_M2014FIS_2 - x
35AB ¥ Recpient Working Version
- 7 \ .
‘ a
5
A B [ D E[F G H ] 1 K smart View - x
1 Financial Statements. =
2 Avg Monthly Number of Children Served Task List @& - »
~Contractual Service Targets.
3 Infants Toddlers Preschoolers JK SK Upto and Including SK School Aged Recreation Informal Server:
4 SUPPORTED WITH PROVINCIAL FUNDING AND REQUIRED COST SHARE ONLY cecviadeapnlal0 service.he.qov.on.ca
5 SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNI. DES COUTS REQUISE SEULEMENT Submission Input and Query -F... +
6
1.0 Submission Inputand QU .
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1.1.2 Schedule 1.2 -
10 Special Needs Resourcing 0 0 000 10 1] 0 [ 8 1135m:d:|:217
11 Service Target 2 0, ) 000 30 1 ) 0 “ .
= + O 1.1.4Schedule 2.2
Microsoft Excel ] ~ O 115 Schedue 2.3-
13 Ontario Works and LEAP - Formal - - - © 116 Schedule 2.4
14 Ontario Works and LEAP - Informal
o SN The cellor chart that you are trying to change s protected and therefore read-only O 1,17 Schedue 2.6 -
15 Total Service Target 3 O 118 Schedue 273
1 %% 7o modify a pratected cellar chart, first remove protection using the Unprotect Sheet command (Review tab, Changes oroup). You may be prampted for a password, ([ | O 1.1.9 schede 2.8
7 | COMPLETE VARIANCE REPORT IF ANY VARIANCE . o 1‘1‘10 schedule 3 "
E E OK
i; REMPLIR LE RAPPORT DES ECARTS EN CAS D'ECH ok ] O i itEedie sl
o - = -0 11,12 Schedule 4.0
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o= O 1.1.14Datz Analysi

6.3 Input data validation

Data validation for Smart View work the same way as for Web forms. The cells in red
are the cells with incorrect data. Cells that have invalid data will be listed on the bottom

right panel.

Dsta  Review  View  Developer  SmartView  Planning
@ Figh Cell Actions - (@ Adjust | More = Approvals
L] 8 Lock N, Drill-through &) Capy Version
Analyze | Refresh
& @ Calculate - B} Submit Data
Ad Hoc Data Workflow
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2 Avg Monthly Number of Children Served Task List & - »
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5 |SOUTENU PAR DU FINANCEMENT PROV. ET LA PART MUNI. DES COUTS REQUISE SEULEMENT Submission Input and Query -F... v
6
7 Fee subsidy = 7 = 5 @ = O 1.0 Submission Input and QU »
& Service Target1 12 ET) 50 5 o £ O 1.1Input and Resuis
5 & - OL115chedue 11+ +
10 Special Needs Resourcing [} o 1 [ [ d ulr G
11 Service Target 2 [] 0 1 [ [} Open Form
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—_——
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15 Total Service Target 3 ) 1 32010 3 [} 13 ] 5
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a0 Data Validation v
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6.4 Advanced Smart View Functionality

To undo data entry in Smart View, the undo button in the Smart View ribbon must be
used, the Excel menu undo button will not perform this function.

@9 <: Excel Undo Button

m Home Ingert Page Layout Formulas Data Faviaw Wi Smart View Planning
— Undo
5 y 9 EL<:I SmartView Undo Button
s o te w

== = m

HE R EE

Refresh | Submit | Oplions

Panel C-:nnede:hc-n‘- .‘!ﬂ;_ e . o B More -
Start Edit Data General
POV Exercise_Input - cscvigdcapwigliservice.cihs.gov.on.ca_TRAIN1_1
| [ ][ sowaviosg verson 1 e e

When attempting to paste a data grid without unprotecting the worksheet the following
error will be displayed, to allow the data to be copied the user must select the Review-
Unprotect Sheet button

Microsoft Excel x|

The cell or chart that you are trying to change is protected and therefore read-only.
—I—l To modify a protected cell or chart, first remove protection using the Unprotect Sheet command (Review tab, Changes group). You may be prompted for a password.

To Unprotect Sheet

& = - =
Home Insert Page Layout Formulas Data Review View Smart View Plai
ABCG -=| ) Show/Hide Comment
’ .'-L ﬂa ] ] 5
— “Unprotect Sheet before Pasting Grid '
spelling Research Thesaurus | Transh J Unprotect
show Ink Sheet W

Once the sheet is unprotected data in the form of a grid can be can be copied and
pasted into the Smart View form.
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User can use Clipboard functionality to Copy/Paste. To turn on please click on the
expand arrow.

Insert Page Layout

i ey
‘ Calibri |1
E3 copy -
Past - -
avs : - Format Painter L =
| Clipboard nl ] Font

Al - | ke |

| of 24 - Clipboard - X A
i Paste All | | Clear All | October [¢
Click an item to paste: [
= - March |«
e : )

;|',;;||;_:|ﬂ|5|m [ RE - T R IR TR

Formulas can be added to any input cell on a Smart View form



Home Insert Page Layout Formulas Data Review View Smart View Planning
[ @ B2l Cell Actions ~ [ Adjust = El More - fﬂSApprovals
==
e S Ol | O ack ¥, Drill-through 3 Copy Version
Analyze | Refresh POV
- M calculate B} Submit Data
Ad Hoc Data Workflow

POV Exercise_Input - TRAINVM04_S1314E2T_1
r |v || Board Active Version |v || YearTotall || 2013-14 || Refresh |

c17 - £ | =ce*1.05 < ] Excel Formula Smart View
I A B T . c Shared Connections
13 |. . | Orade® Hyperion Planning, Fusion Edition
14 Junior Kindergarten (JK) 105.00
15 Senior Kindergarten (SK) 210.00
16 March Enrolment  Grades 1to 3 315.00
17 Grades4to 8 | 420.00]
18 Total Elementary 1050.00
19 |. o
20 March Enrolment  Elementary (21 years and over) #Missing :
irn) al C121AFCT
21 . o
22 Grades 9 to 12 (under 21 years) #Missing Document (  Planning Connection
23 March Enrolment  Grades 9 to 12 High Credit (under 21 years) #M!SS!ng Emart\ien—-Oixrent Do "
24 Grades 9 to 12 (21 years and over) #Missing Smart View
25 Current Document
26 Sheetl
27 All Connections
TRAINVMO4 | 51314E2T
28

Data can be linked in from other Excel Workbooks

-
Hame Insert Page Layout Formulas Data Review View Smart View Planning

(-] @ ﬁﬂCeIIActions' ) Adjust - Bl More ~ %gApprovals

—=

ES) = 81| 8 Lock ®l, Drill-through %2 Copy Version

Analyze | Refresh POV
- B calculate = B} Submit Data
Ad Hoc Data Workflow

POV Exercise_Input - TRAINVMO4_S1314E2T_1

|7 - | Board Active Version |v||'T'EE-I'TC'tE||1 2013-14 || Refresh |
Ccl4 - F | ='Cc\Users\Admin\Dropbox\EDU Phase 1\70 Training\Board Training Documents\05 Ex. .
A B | c | D
LR 2 Smart View
14 Junior Kindergarten (JK) I 4809.00| i
h . Shared Connections
15 Senior Kindergarten (SK) 5625.00
16 March Enrolment IFO rmula for Iin king data from 315.00 | Oracle® Hyperion Planning, Fu
17 ( 420.00| [ == TRAINVMO4
= .other Excel Workbooks mr— g 51314 G5
19 . ] E| ' S1314E2T
- : [E7 Forms
20 March Enrolment Liciiciwny yes posrowm weerg wrenna3iNg
21

Smart View workbooks can be saved and the data can be submitted at a later point
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Ex3.xlsx - Microsoft Excel

nHome Insert Fage Layout Formulas Dy Review View Smart View Planning (-] e‘ c
lel__] @ B8} Cell Actions ~ [ Adjust * E - 2:3 Approvals
(i .5 Lock EL, Drill-through &3 Copy Version
Analyze Refresh
= B Calculate - EJ} Submit >Saved Workbook
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7 Submission Management

7.1 Overview of Versions

Submission management allows Recipient users to manage the versions or
submissions that they are working on. The tools provided give the user the ability to
copy data between versions (such as the working version and the drafts) and to
promote the version for review as needed (using the Workflow / Approvals Management
process).

Thiz wersion allow s the Becipient User to work on their submizsion by
entering data and running calculations, Alkhough data can be copied
ta and from this version, this is the only version which can be verified
W0 Recipient 'working Version ™ and promated in the Approvals moduls.
"l e SLbTHRSIT A B RAOITRONER e Serens o this versicn
CARITES P FREANT rre Sy st e SRS CarvRCT e e O copmied o
V10001 Becipient Oraft 1 _ : ) ) Versians
V0002 Focinient Draft 2 Diraft versions are also versions that the user can manipulate data in. Fecinient Llser
P ) - P
VAOO S Recipiers Diaft 3 They are used during the submission pmcesslto manage l:llate! chan.ges A
VAOOG Recipiera Diah 4 and ke_ep back-ups wheh nesded. Hm.«- euer, if 2 draft versionis th.e final
D005 Recipient Oraft5 version that the user wishes to submit, they must copy the datainte
SEpISELTS Recipient ‘working WVersion.
L0008 Fecipiert Draft 6 i .
Version far review by FA. The F& doss nat have access to view
Recipient ‘Working Version. If a Recipient User needs the FA ta review
VIOFOW Recipient F& Yiew able Version the datain that wersion for any reazon, they would copy the data inta
"Fi& \iew able Version™. This allows for the F& 1o review and give
feedback to the Pecipient User.
w0007 Blank Template For Resst Used as ablank draft that can br?- usedtacleararreset datain a
WETsion.
YIERD Bt G A Vs Uzed at the paint where F\ppro\.::er submits t?lat? that has errors butis
tagged as "Error Override”.
The final version which is submitted to the Ministry, Once the Recipient
W0 BeeleAale Wastn User lplomotes the I.:lecipient ‘working UE‘lSi.DI'I, :an appm-.lel.isl
responsible for approving the data and prometing it ta the Fecipient
Active Verzion,
W01 Recipient Inactive Wersion 1 Versions
W0z Recipient Inactive Yersion 2 Recipient User
W0I03 Becipient Inactive Merzion 3 can read from
W04 Recipient Inactive Yersion 4
\0I05 Recipient Inactive Yersion 5 Wersions used as a historical { audit record of previously active versions.
WI0I06 Recipient Inactive Wersion B
\waiov Recipient Inactive Yersion T
0105 Recipient Inactive Version 8
W10I03 Fecipient Inactive Version 3
w20 F& Active Yersion The final version which is submitted by the Ministry far pavout purposes. |

The user is able to write to all the versions in the list that are coloured purple. The data
can then be copied from one version to another as need (i.e. if the user wants to create
a “backup” of a certain version they can copy it to a draft or when the user needs to
push data into the FA Viewable version for an FA to review it). However, only the data in
Recipient Working Version can be promoted during the approval process. When the
user is ready to submit the data they must make sure that the correct data sits in
Recipient Working Version. Any data management and movement are done by using
the Copy Version process.
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7.1.1 Copy Data Between Versions

To copy data between versions, the user selects Tools = Copy Version

ORACLE Enterprise Performance Management System Workspace, Fusion Edition

Preferences

The following Copy Version screen is displayed

Copy Yersion
Planning Units
Select a scenario, source wersion, and destination version, Then click Go ko retrieve the lisk of entities.

* Srcenatio | <Select Scenario> LI * Copy From | <Select Version= LI * Copy To | <Select Yersion = LI il

Available Entities selected Entities

&

Mawve:
Mowve Al
]

Remove

Remaove Al

r Copy Account Annoktations
- Copy Commenks
r Copy Documents

r Copy Supporting Details

Copy Daka

Select the Scenario related to the application (Cycle) the user is working in. (Although

other cycles are shown in the drop down box — they are not applicable and nothing will
be copied if one of them is selected).
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Copy Yersion

Planning Units

Select a scenario, source version, and dr“_“_|5u:enario ersion, Then click Go to retrieve the list of entities,

* Srenario | <Select Scenatio>=  w || * Copy From | <Select Version= LI * Copy To | <Select Version= LI ﬂ

Available i EES Selected Entities
Financial Statements
Mo Scenaria B
Revised Estimates Move

Move &l

g

Remove

Remove Al

r Copy &ccount Annokations
- Copy Comments
- Copy Documents

O Copy Supporting Details

Copy Daka

Select Copy From Version (Recipient User sees list of scenarios they have read
access to)

Copy Version

Planning Units

Select a scenario, source version, and destination version, Then click Go to ret entities,
Copey From

* Srenario | <Select Scenario > LI * Copy From || <Select Yersion> * Copy To | <Select Version= LI il

Available Entities V10 selected Entities
V10001
Vioooz
V10003
V10004
V10005
V10006 |
v1ooo?
V10ERO
V10RO
V10101
V102 W
V10103
V10104
V10105
V10106
V107
V10108
V1009
(il Copy Documents V10w
V10T
i i V1WA
(il Copy Supporting Details bl
V10WDY
WZ0
a9

(l Copy Account Annokations

[ Copy Comments

Copy Daka

Select Copy To Version (Recipient User sees list of scenarios they have write access
to)



l[:upy Yersion

Planning Units

Select a scenario, source version, and destination version, Then click Go to retrieve the list of entities, Copy To
* Scenario | <Select Scenarioz LI * Copy From | W10 LI * Copy To | W10001 - i—l
<Select Version >
Available Entities Selectef Tyl
Viopoz
b ¥10003
Mave Y¥10D04
V10Dos
& 10006
Move All V10D07
V10RO
g V10w
Remove
Remove Al

r Zopy Account Annotations
O Zopy Camments
- Copy Dacuments

- Copy Supporting Details

Copy Daka

Click the GO 2! button.

Under Available Entities you will see the Recipient that user is responsible for.

Copy Yersion

Planning Units

Select a scenario, source version, and destination wersion. Then cick Go to retrieve the list of entities,

* Scenario | Estimates :I * Copy From | V1OW ﬂ * Copy Ta | ¥10DO1 ﬂ 1|
Pivailable Entities Selected Entities
[ M30003
b
Move
Maove All
Rcranw:
Ramové All

I™ Copy Account Annotations
™ Copy Comments
™ Copy Documenits

™ Copy Supporting Detais

Select your Recipient name and click the Move or Move All button to move the Entity
into the Selected Entities box. Check off all of the options for copying additional

information that has been attached to the version. Click the Copy Data button to run the
Copy process
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Copy Version

Planning Units

Select a scenario, source version, and destination version. Then dlick Go to retrieve the list of entities

*Scenario |Estimates =| *Copy From [viow | *Copy To |vioDo1 = =
Available Entities Selected Entities
[+ M90003
Mo
53
Move Al
<
Remave
Remayve Al

W Copy account Annotstions
7 Copy Comments

W copy Documnents

W copy Supporting Detais

Copy Data

A window will pop up to confirm that the user wants to run the copy process and
override all data in the “Selected Entities” for the “Copy To” version

[Eup',r Version [x%]

‘ You are about to copy versions, which could change vour current data walues, Do wou want to continue?

|

Once the process completes a window will pop up to inform the user that the copy was
successful

Zancel

[@ Information [x]

The version has been successfully copied,

7.1.1.1 Copy to FA Viewable

If a Recipient User wants the FA to preview data before submitting it, they have to copy
a version into the FA Viewable Version. The reason for this is that the FA does not have
access to any of the Recipients versions until they are set to Active or FA Viewable.
This would be done using the Copy Version process.
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7.1.2 Version Description and Summary Dashboard in the task list

The Version Description and Summary — Submission Dashboard allows users to keep
track of the versions they are working with. It is a place that allows the user to see the
current status of their submission (whether it is active or not) and to add descriptions to
each of the Draft versions available. This way the user can know where their data
currently sits and can easily work on promoting the correct data as part of the Sign-off
and Approvals process. The right hand panel shows the history of the versions that

were activated over time.

ORACLE'

¥ Forms Task List Status
My Task List ek - Viersi

shboard | Task Instuctons

R S R RS
- Modifier_Gestion de la soumission - Meodificd

-3

5 Submission Status
——

i Soenario: Financiel Statements

#Pesiod: YearTotall

H vear 2014 5. Categoey: No Catagory 0. SubCategory: No SubCategory

V20iFA Active Version

V10:Recipient Active Version | Not Amive/inaci.

Not Active/Inactf

- -
‘Submission Status | Activation Date | Submission created by: | TP Activation Date | TP Process Complete

e
I

I | v10W:Recipient Working Version
V10001 Recipent Draft 1
V10002 Recipient Drafi 2
V10003 Reciient Dra: 3
V10008 Recipient Draf: 4
V1005 Recipent Draft 5
V10006 Recipent Drf §

V10D07:Blank Template For Resst

V20:iFA Active Vession

V10FOV:Recipient FA Viewable Version

Version Descrption}

Acivaon Date | Version Deszipton
V10ERO:Recipient Exror Ovasride Vassion

¥ 10:Recipnt Active Version

'V 10101:Recipient Inactive Version 201502/10
V101021Recigien: Inscive Version 2015102106
V10103:Recigient Inscive Version

V10104 Recipient Insctive Version

n

V10105: Recipient Insctive Version
V10106 Recipien: Inactive Version
V10107: Recipient Insctive Version

V10108: Recipient Insctive Version

© @ v m |0 & ju |n e

V10103: Recipient Insctive Version

V20:FA Adive Version

& Pyeferences

Complete: [ | Previous Incomplese || Previous || Nex Incomplese || Next || Task List Home

7.2 Approvals Process —Modifier

The Submission Management task list is used to manage sign-off and approvals as the
cycle moves along. Recipient users would use the Input task lists to enter all necessary
data and calculate the submission. Once the submission is ready for final validation and
promotion, they would enter the Submission Management task list and run through a
number of steps to promote the submission.

As mentioned before, the data which is ready to be validated or promoted must be
stored in the Recipient Working Version (the Version Copy process outlines this in more
detail).

It is recommended that the user first review and address any Errors and Warnings and
Input Validation errors prior to beginning the Sign-off and Approvals process.

The validation and promotion functionality is done by running the following steps:
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7.2.1 Flag Submission for Approval

Select Submission Management > Flag Submission for Approval task. In the row
“Are you sure you want to promote the current Submission for approval?” select Yes”
from the dropdown menu. Click the Save button. Each time a change is made to a
submission, for example correction of invalid data or removal of an Error, the flag must
be re-set. This is to ensure that the most recent data is being validated.

Edition sgged in s EFIS. TRAINEROI@GMAILCOM | Help | Log OFF §

-
e I © -

Task List Status

| Task - Flag Submission for Approval-PROMO - Task Instructions
4, Period: YearTotaly #vesn 2014 & scenario: Financal Statements 4, Gategary: No Gategory 14, SubCategory: No SubCategory
5AB e

Are you sure you want 1o promote the cument Submission for approval?

SaBEs Bl ORI, £190)

7.2.2 Validate Submission

Select Submission Management and open the Validate and Promote for Approval
task

ORACLE' Enterprise Performance Management System Workspace, Fusion Edition Logged in 25 EFIS.TRAINEROIEGMAIL.COM | Help | Log OFF

Navige Tooks Help

e I

Sl M2014FIS - Task List Status %

& Forms Task List Status E
My Task List Task - Validate and Promote for Approval-Manage Approvals — Tzsk Tnsmuctions
e B . 5 -
= 1 S Quny - FE_Seumision Enide e requia Seenario | Finandal Statements ] Vession | Recipient Werking Vession [] | Go Out of Office Assista
& F subr Modifier_Gestion de Iz soumission - Mod =
= @ Process status View ~
Char Type | Pe [o] Group By = )
Adborse Vew~ @@ % BT @ F Dk
Dlanning Unit & [Approvak Sens_ T[oubSams  [Cument Owner  ]Locaton [ P | Demis
)5AB | ot Signed Off | | MoC_Ms0oo3w osaB | 2%

Select the your Recipient name shown under Planning unit and click on Actions
->Validate
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CNRALLE ttrprsss Frvtsrmsmon Manspreersl Sysiom Srringst

e Tanks it Shabm.

e B T =

P S T ————

() ————

i P et Wi <P vl i e

v dbrwr st Bt

——
S Geme W% B Foven

a5 EFIS. TRAINERDI@GMAIL.COM | Help | Log OFf €

Task List Status

Task - Validate and Promote for Approval-Manage Approvals | Task Insructions

nd Query - FS_Soumission- Entrde ot requdte

Scenzrio | Finandal Statemens [ ] Version | Redipient Working Version G
- Modifier_Gestion g Iz soumission - Modi - Elle)

B Process Status

"ot of Offce Asseta

View -

CranType P[] Grous By =

'+ ¥ validate and Promate for Approval
@ P Gestion de |a soumission

L]

Adorsw] Vew- 3@ % [ @ & Deah

[I B Display My Pianning Unis

|4 T Clear All Fihers

= V[Approvak Sens__F[oubSws ¥ |Gurent Owner 7 |Locaton 7] _Peth | Demis
| |Mcc_msoooaw [ P i

%, Defauk Sort
B validze
¥ Change Stams
B Refresh

As the validation process takes a few moments you can click on the Refresh button to
refresh the process and see the results. If there are any errors found during the
Validation process, the Sub-Status will be displayed as Invalid Data. When there are no
more validation errors the Sub-Status will display No Additional Approval Required.

sgement System Workspace, Fusion Edition

15, TRAINERDLEGMAILCOM | Help | Log Off €

seach I © =

Trorss |

| Task- Aop rovals  Task Insvucions

Scerro | Fnancal Statemens [ ] Veron | Recpent Uorkng Verson [ ] | G0

T T 1 —

e O lecaeon
see | 88 | O |

[ Path | Demis |

67



Select the Invalid Data Hyperlink and a new Task List will appear under My Task List
and will outline all the forms that contain validation errors in them

Logged in 25 EFIS. TRAINEROLGGMAIL.COM | Help | Log Off O

-
LR M2014FIS - Task List Status * Sexcch [ © A:arcx
Task List Status E

Task List Status - All View w

Incomplete. 100.0%

1 Close Task List Window

Task List Tasks - All

Type [Sins Due Date Alet Complered Date | Instructions Adtion
] &
] @
5l @
= @ &
o, =
3 =)
[
5l g Closa Task Lt Window @ ¥

Selecting the error task in the Task list will take the user to the error that needs to be
corrected. In the example below, the user is directed to an Error Form indicating there is
an error on Schedule 2.3. The user will navigate to Schedule 2.3 to remove the error.

sgement System Workspace, Fusion Edition

M2014FIS - Task List Status *

& Forms [Task List Status
- Task - Errors-Errors | Task Instuctions
4 Period: YearTorall ] Vear: 2014 ], Scanario: Financial Statements 2. Category: No Category EJ
8 == T 5h8 O] g
Vael | Vaed | Ero et Acceps Eror Descrpton - Engish I
Tndicetas # thare s any sror inthe subrisson and 5 |E
Ho SubCategory whether to roceed with submission regardiss of emar B
i
o data has been entered for this schedule (1wl &
Eror SCL1 1 Mo/ rion Schedule 1.1) (]
5 Schedule 1.1 Emors
Eror SC12.1 25 222|Na/N
Eror SCL22 222 No / Mo
Eror 5CL23 7 2NN
Eror SCL2.4 5| a2[Nesm
= Schedule 1.2 Emors
Eror SC21.1 No/ Non
e data has been emered for Number of hours wih
Eror 5C21.2 Mo/ Non "YES” drop down selected
= Schedule 2.1 Emors
The FTEn Column 3 cannat eeeed the number of
Eror SC22.1 No/ Non staff reponed in Column 2
o dara hes been emered for Number of hours with
Erer 5C22.2 Mo/ Non "YES" drop down selecced
‘Schaduie 2.3 otal adjusted gross expenditres must
Eror SC231 | 4,796,585 4,795,585 ‘el Schedule 2.4 total adfsted gross exenditures i
= Schedule 2.3 Ermors
Grly DSSABS are slowed 1o enter TWOMO
Eror SC27.1 No/ Non expenditses on Schedule 2.7
5 Schedule 27 Erors
The ol amount on Schedul 28 shouk b saual 0
Eror 5281 32.000| 332,000 No / Non e o st parcs el 2.3
& Eror SC2E
| | +
S rciore Gompiete 7] | Previous Incomplca || previous || nex incompies || e || Task Lt Home

The user must locate and correct all validation errors before the Submission can be
successfully promoted.

Once the validation errors have been corrected, the user can either rerun the
Validation process to ensure they have not missed any errors or move directly to the
Promote process.
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NOTE: To rerun the Validation the user must re-set the Flag Submission for Approval
to Yes.

ORACLE’ Enterprise Perf: Management System Workspace, Fusion Edition gged in as EFIS. TRAINEROI@GMAIL.COM | Help | Log OF §

-

Task List Status

| Task - Flag Submission for Approval-PROMO - Task Instructions
4, Period: YearToral #Vear 2014 &} Scenario: Financial Statements 4, Categary: No Category 14, SubCategory: No SubCategory
5] -

Are you sure you want 1o promote the cument Submission for approval?

SaBEs Bl ORI, €190

When the Submission passes the validation, the sub status will be updated to No
Additional Approval Required and the Error Task List will be removed. The
submission is now ready to be Promoted.

Logoff O

ORACLE' Enterpri ision n Log 15.TRAINERDIGGMAIL.COM | Help

-
=% M2014FIS - Task List Status * Se=ch [ © -cvoc=

 Farms Task List Status A

Task - Validate and Promote for Approval-Manage Approvals  Tzsk Insuctons

ncial Statements [, | Version | Recipient Working Vesson [ ] | Go
View
] L]
Adions~ View- 3 W@ % B @) B Dewh
Planning Ut = V| Approvak Stmos ot Owner W [locacon N[ _path [ Detais
S4B [Not Signed off No Additonal Appr{ fCC_MS0003W DSAB = | O
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7.2.3 Promote Submission

To promote the submission to the Recipient Approver select Submission Management
- Validate and Promote for Approval and select your Recipient name under the
Planning Unit.

ORACLE' Enter s gement System Workspace, Fusion Edition EFIS.TRAINERDLGGMAIL.COM | Help | Log o O

M 12014515 - Task List Status % e

¥ Forms. Task List Status

Task - Promote for Appr rovals) | Task Instructons

Scenaro | Financisl Ststements [ | Verson | Recpient Working Verson [ ] | Go Ot of Offe Assita
[ Process Status View o

Chart Type [Pie[w] Growp By =] @

Acionsw View- @ % @ o @) Detach

AT ESeus  V|SwbSwns  V|Cument Owmer ¥ |Locaden W[ Path | Desik
S4B || [ Mo Signed OFf | No ddivanal Appe{ MCC_Ms0003W DSAE 2] =

I

Once the Recipient name under planning Unit is selected select Actions 2 Change
Status.

EFIS. TRAINEROLEGMAIL.COM | Help | Log OFF

M2014FIS - Task List Status * search [N © A=
& Forms Task List Status
Task - validate and Promota for Approval-Manage Approvals | Task Irsructons
Scanario | Financil Sttements [o] Version Recipient Vierking Verson [] | Go ut of Offis Asssia
B Process Status o View »
Chart Type | Pie [] Group By = Y

- BEuc@c@ Hoss

[ Display My Planning Units A 7|Approvals Status 7 |SubStatus | Gument Owner 7 |Location 7| Path | Detais
Tl Clear All Fiers [Not Signed OFF [No Addional Appr MCC_MS0003W 5B | o | [ |
%, Default Sort
[ validecs

The Change Status screen will appear. Select Promote from the Select Action list and
the Select Next Owner will be populated with Automatic. Enter comments if required,
then select OK
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thart Type | Pie El Group By El

Change Status

I Selact Action | Promote E}eect Next Owner | <Automatic> g

Enter Annctation

Actions»  View - Bg % B |Tahoma El 2%_? _? @@ &.Mw |:|

Yznning Unit

First Training DSB

e Status T | Sub-Status i
Enter Comments here

Current O
Mo Additional Appre EDU_BOX

Help

The submission will be promoted to the Approver and the Recipient Working Version
will now be changed to Read Only.

System Workspace, Fusion Edition

EFIS.TRAINEROLBGMAIL.COM | Help

Log Off

SN M2014FIS - Task List Status *

e — 1
Task List Status
Task - Validate and Promote for Approval-Manage Approvals | Task Insructons
" | Scensro | Financial Stetements [ -] Version | Recipient Werking Vession [ ] | Go ‘Qut of Cffice Assistat
@ Process Status T Visw v
Chart Type [Pie [o] Group By [ kY

Actors~ View- B % 7@ [ Detsch
Planning Unit 2 7A k Siatss ¢ |Sub-Status. 7 | Cument Owner 7 |Location 7| Path | Detais
Algomz DSAB |Under Review | MCC_Recipient_approviTotsl Recpiems | 38 | B

If a user attempts to promote a submission when there are validation errors the Sub-

Status will be displayed as Failed: Invalid Data. The user will be required to correct the
validation errors and then re-do the Promote process.
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Task List Status

Task - Validate and Promota for Approval-Manage Approvals Tzt Insucton:

Planning Unic & 7 [Appovak Stans.

7.3 Manage Approvals —Approver

Once a submission has been promoted by the Modifier, the Modifier no longer has write
access to the Working Version and the next user in line is the Approver. The Approver
is responsible for reviewing the submission and deciding how to proceed with it. The
Approver has two choices: running the sign-off process on the submission or rejecting
the submission. If the Approver decides to reject the submission, the submission is back
in the hands of the Modifier.

Once approved, the data is automatically copied from the Recipient Working Version to
the Recipient Active Version as well as the FA Working Version. At this point the status
of the submission is set to “Active” and the FA is responsible for continuing the process.

7.3.1 Approve and Sign-off

Select Submission Management > Recipient Approver Sign-Off. Within the form
click the dropdown beside “Are you sure you want to sign-off the current submission?”
and select Yes then select Save.
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ORACLE' Eenterprise Performance Management System Workspace, Fusion Edition

& Forms Task List Status

My Task List Task - Recipient Approver Sign-Off-Sign Off - Task Instuctions.

= B Submission Input and Query - FS_Soumissig i, Scenzrio: Financial Statemants 4 Period: YearTorsll 4 vesr 2014 . Catagory No Catagory 2. SuhCategony: No SubCategony
= ¥ Submission Management - Approver_Gestio o -
= F submissen Mansgement =
- _ _ £ Submission Status
I B bmission Status | Activation Date | Submission created by: | TP Activation Date | TP Process Complete
1 V10:Recipient Acive Version | Not AcivelTnac
5 I Gestion de Iz soumission
V20:FA Active Verson Not ActiveInactif
= Sign OFf Confimatian
Resipient Warking Version
] || Are you sure you want 1o promete the curent Submissio for approvai? | Yes / Oui
Areyou e you want o sgnff | 1
L = ]
Name ]
Name
Lol
e/ Oui |

Complete [] | Previous Incomplete | | Previous

Next Incomplete || Nest || Task List Home

The status of the Submission will be changesd to Active and the Activation date will be
updated.

ORACLE" enterprise

System Workspace, Fusion Editian

M2014FIS - Task List Status *

& Forms
My Task List

Task List Status

Task - Recipient Approver Sign-Off-Sign OFf | Task Instructons
Seenana; Financizl Statements
£ -4

i B Submission Input and Qu
= ¥ submission M=

- F5_Soumissiol
jement - Approver_Gestor
21 Submission Management

4, Period: YearTotall

14 Categorys No Categony 4. SubCategany: No SubCategory

, T
& 9 Version Desrpson and Summs
= © e - id Submesion Status | Activation Date | Submession ested by1 | TP Actvaton Date| TP Proess Complece
& O Reject Submission Active Verson | AcivelAck 2015/02/11 2015/02/11
1 I Gesmion de Is sumission
V204 Active Verson | Not Acivellnactt
= Sign OFf Confirmaton
Recpient Viorking Verson
Are you S you want 1o promets the cument Submission for approval? | Yes | Oui

.

Are you suwe you want to signoff s
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7.3.2 Reject and return submission to the Modifier

If the Approver decides that the submission is not satisfactory and not ready for further
sign-off, the approver can return the submission to the original owner (Modifier).

To reject a submission select Submission Management > Reject Submission

rise Performance Management System Workspace, Fusion Edition Logged in 5 EFIS. TRAINERD2@GMAIL.COM | Help

Tooks Help

Task List Status

Task - Reject Submission-Manage Approvals | Task Insvucions

Scenaric | Exens finanders [o] Version | Version de wavai de s destinaaire [ ] | Go Dut of Office Assists
@ Process Status Vo
Chart Type [Pie [] Group By =l [

Actorsw View- B % @7 @ e
Pianning Unit AFA ks Stanus 7 |Sub-Stats. 7| Cument Owner 7 Locaten 7| Path | Detais
DSAB. |Under Review | |MCC_Recipient_ { Destinatsir e 23 | B |

Once the Recipient name under planning Unit is selected select Actions = Change
Status.

ORACLE’ Entsrprise Performance Management Systam Workspsce, Fusion Edition ogged in 25 EFIS.TRAINEROZEGMAIL.COM | Help | Log Off
Navig Took Help

-
Sexech [ © =~
Task List Status
Task - Reject Submission-Manage Approvals  Task Instuctons
Scensrio | Exats finanoess [ ] Version | Verson de wavail de & destnare [ ] | Go Out of Offica Assita
§ Process Status View v
Chant Type | Pie [5] Group By =] Y
Viewo TS GRcf @) [ Dewch
(B Dispizy My Planning Unins 2 V[Approvak Stats__ ¥ [SubStatis ¥ |Qunent Owner ¥ |Location [ Pan | Dot
T Clexr All Fihers | Under Review | MCC_Recipient_Approv{Destinataires wiales S8
%, Defauk Sort
B vaidzs
o§ Change Stamus
) Refresh

The Change Status screen will appear, select Reject from the Select Action list, Select
Next Owner will be populated with Automatic and enter comments if required, then
select OK
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Change Status

@‘_

Celect Action

Reject

Al

Celect Next Onener | <Automatic:

B

IEnter Comment here I

Help

Ctatus | Sub-Status

The Approvals status will change to Not Signed off. The Owner will revert back to the
Modifier and Recipient Working version of the submission is no longer read only and

changes can be made.

System Works,

EFIS. TRAINERDZEGMAIL.COM | Help | Log Off

-
eoch I © =

Task List Status

Task - Reject Submission-Manage Approvals  Task Instructoss

B Process Status

Scenario | Etats financiers [ | Version

Version de wavail de |2 destinstare [ || B0

"Dt of Offce Asssts

Vieww

Ghant Type [P [ Group By

=]

[ Acons - View~

Sy @@ e

[Planning Unit

SAE

7] _Path | Detais

S b-Status |Location
Not Signed Off MCC_MSDD03W osae | 23 | O

7.3.3 Submission with Error Override

Under special circumstances a Recipient may need to promote a Submission that
contains errors. In these rare instances, the Modifier will set the Recipients Accepts
Error Flag to Yes then follow the normal submission process. In this case the data is
automatically copied from the Recipients Working Version into the Recipients Error
Override Version. From the perspective of the Approver the process follows the exact
same steps as outlined in the previous section for a submission containing no errors.

75



After the sign-off by Approver, the data still sits in the Recipients Error Override Version.
At this point, additional steps will be required by Ministry personnel. The Ministry needs

to confirm activation of submission with errors. Upon successful completion of this step,
the data is copied from Recipients Error Override into Recipients Active Version and FA
Working Version. Please note that once you have promoted the version with errors you

need to contact the Ministry in order for them to perform the additional steps required.

Select Submission Input and Query > Errors and Warnings Error - Errors and
Warnings select Yes from the Recipient Accepts Error drop down list and select
Save

Edition

& Forms [ Task List Status

Task - Errors-Errors | Tzzk Instucions

4 Period: YesrTorall Hivesr: 2014 1, Seenario; Financizl Statements 14 Category: No Category
Recpant Vioriing Versen X -2

Vakel | Vake] 7 et e n - English |
Indicadls # there. |
2 Jorne i the

Mo SubCategory.

= 9 e 2. Eror_SCL11 No / Nen Name
M ¥ Schaduls 2.4 - Projected s Iina—l
0 9 Schaduis 2.6 Miscelznzovs B.Schadkde 11 Em s
¥ Schedule 2.7 - THOMO Reimburses Evor SC1.2 1 208 222 | No / Nen
B 9 Schedule 2.8 - Capacity Funding 1o/
8 9 Schedule 2.0 - Allocations for Operf] | ET-5C12.2 n 222 | No/ Nen
8 Schedule 3.1 - Entitement Eror_SC1.2.3 7 222| Mo/ Non
8 Schedule 4.0 - Mit
Eror_SCL2.4 223 | Wo / Nen

m

E Schedule 1.2 Erors

Emor SC2.1 1 Na | Nen ‘Golumn 3 cannor

Emr_SC21.2 No / Nen

5 Schedule 2.1 Eors

The FTEin
Emor SC22. 1 Na / Nen ‘Golumn 3 cannor

No data has beer
Ermor_5C2.2 2 No / Non for

E Schadule 2.2 Errors

Schadule 2.3 ol
Erer SC2.3 1 4,796,585 | 4,795,585 adjusted gross T

& Schedule 2.3 Eors

Eror SC2.7.1 Mo/ Non are 2

5 Schedule 2.7 Eors

Error 5C2.8 1 332,000| 332,000 No/ Non on Schedule 2.8

B Ermor 5028

b

The Recipient Accepts Error flag is set to Yes
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ORACLE’ Enterprise Parformance Management System Workspace, Fusion Edition

% Forms Task List Status
My Task List Task - Errors-Errors | Task Insvuctions
B Subevission Input and Query - FS_Soumissio 42, Period; YearTotzll #ear: 2014 £} Scenario: Finendial Statements J_ Category: No Category
B B Submission Input and Query = = Tl
& P 1nput and Resuhs =
=~ Vahez 2| Recipient Acoepts Emor | Descrption - Engish
1 % Schedule 1.1 - Convractual Servics Indicates f there g
B ™ Schedule 1.2 - Other Service Targefj | No SubCategony Yes | Oui s any emorin the. n -l
& Schedule 2.1 - Staffing (Direct Deliy
& Schedule 2.2 - Staffing (Chid Care —
1 9 Scheduls 2.3 - Adjusted Gross Bipelf | Emor sCL1 1 No / on entered for this
Schadule 2.4 - Projectad Expendims =
P & Schedule 1.1 Evors
1 9 Schedul 2.6 - Miscellsnecus
19 Schade 2.6 - iscel T e
™ Schedule 2.7 - TWOMO Reimburse Evor_SC12 1 208 222 Noj Non children served
Schadule 2,6 - Capacity Funding 1 The rumber of
9 Schadie 2.0 Allcatons for Oper] |_EMSC12.2 n 222| No / Mo chikiran serv
The number of
Schedule 3.1 - Entlement Emx_SCL2_3 78 222 No / Non chikren served
Schadle 4.0 - Mitigation Funding The rumber of
19 schadule 4.1 - Capual Carry Forwalf | _EFoe.SC12.4 s 222| No f Mo chikdren served |
1% Data Anzlysis and Review B Schedule 1.2 Emors
E] " The FTEm
Eror SC23 1 Mo/ Non Golumn 3 cannor
aF No data has been
. Emor_SC2.1 2 Ne / Nen entened for
5 Scheduls 2.1 Ervers
@ b The FTEn
. Evor SC22.1 N/ Non Galumn 3 cannor
& B valdztion Formats [ =y == e
& B Soumision Entrée et requite Eror 5C22 2 No { Non entered for
5 I Submission Mansgemen: - Modifer_Gestion s
‘Schedule 2.3 wial
Ero SC231 | 4796585 4, adjusted gross -
5 Schedula 2.2 Evors
Onhy DSSABS
Emor_SC27_1 o / Non e allovied
5 Scheduis 2.7 Ervers
The total amount
Eror_SC28_1 332,000| 332,000 No / Non on Schedule 2.8
© Eror SC2.8 il
< i 3 Sastion desgel
F profarences Complete [] | Previous Incomplete. || previous || Net Incompiete || mese || Task i pome

Modifier follows the normal Promotion process.

ORACLE' Enterprise Workspace,

 Forms Task List Status il
My Task List rovals) | Tack Instructions
S Oy [ — [=] Verson [Board Werking Verson = R
& P ot =
» § Process Status Ve~
& ¥ Reports.
o Chart Typ= | Pe [w] Group 8y =] 7]

& P Reference Data
& B vaidaton Formats
& P Subnssion Mansgement
# ¥ Version Description and Summary
09 Fiag Submisson for approval
+ ¥ validate and Promote for Approval
[ Soumision - enrée ot recuite Select Acton [Promets [ Seect et Qviner | <Avtomatics =
71 B Extimates - viow - Booon2

Change Status [

Enter Annotation

e e al Cl = @ - ¢ [ & |
e (Bruis¢gs] N T[substas V| CurentOwner 7| Locaton 7] path | petas | [
[Second Training DSB: Promoted with Errars | Failed: Tnvaiid Dot | EDU_B00DIZW. |Second Training 05| E¥ | [ i

Hep ok | | cancel

4l Preferences Complete [] | Previous Incomplete || Previous || Next Incompist= || Next || Task List Home

The submission owner is now the Approver and the Recipient Working version is
changed to read only
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ORACLE' Enterprise Performance Management System Workspace, Fusion Edition

* Forms  Task List Status
My Task List Task - Validate and Promote for Approval-Manage Approvals -~ Tzsk Insructions
= ¥ Submission Input and Query - FS_Soumissiol

Seenario | Financial Ststements [ Version | Redpient Working Version [] | G
| Process Status

CraType | P[] Group By

=

Out of Office Asssa

View -

.0 - Allogations for Opars

]

.1 - Encidement [[(Actonse Vew- % @@ v

5 0 - Mitigation Funding [Plznning Unit = A EStans 7 |SubStans

me .1 - Capital Camry Forwall | J5AB. |Under Review
1819 Dats Anslysi and Review

@ ™ Guideline Adherence Confirmation ‘

Approver follows the normal sign-off process

ORACLE Enterprise

System Warks,

Fusion Edition

# Forms | Task List Status
My Task List Task - Recipient Approver Sign-Off-Sign Off - Tzsk Insruzmians
= I Submission Inpu nd Query - F5_Soumisss 7 Seenane: Financial Statements 4 Period: VearTotll £ ¥ezn 2014 ). Categary: Ne Categary 14, SubCategory: No SubCategory
= ¥ Submission Manzgement - Approver_Gestio ceie o
5 P Submission Management —
_ g o ~ E Submission Status
I = e —— Submission Stas | Acivatien Dave | Submission crested by: | TP Activatien Date | TP Progess Complete
——— V10:Recipient Active Vession | Not Adtivelinacef
& P Gastion da la soumission
V20:FA Active Version Not Active/Tnactif

= Sign OF Genfimstion
Recipient Working Version
bl | [ Are you sure you want to sromote the curent Submission for spprovai? | Yes / Oui
Are you sure you want bo sign-off NSk I
! Eolfies [C]
Name ||
Name
Mol
s ] oui |

| i
& Preferences

Complete [[7] | Previous Incompiete || previous

Nesa Incomplete || Nesa || Task List Home

The Approver will receive the message that the Submission has been sent to the

Pending Error Override.

Administrator (Ministry) for error override and the submission status will become
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ORACLE' Enterprise Fusion Edition Logged in aa EDU_B000N2_AR
rtes Took Help

Bo =3B &

5 Forms Task List Status
My Task List

Task - Board Approver Sign-Off-Board Sign Off  T=sk Instructions

= ¥ Submission Approval

= ‘Scanario: Estmates 4 Pericd: YearTotalt J SubCstegory: No SubCstegory
B Z
b Treining DSB ~ =
& P Reports o -
- Active Fl
& Resutts
& B Reference Data |@ Error £
& B vaiidation Formats Sunsiss s
ool F— ‘Submission sent to admin for error verride. | Soumission envoyde  fadministrateur pour annuler
£ I submiesion Mznzgement 4 ive Version INGEAEHVEMINS 1o rey,
1 Version Description and Summary =
7 ¥ Board Approver Sign-OFf _
7 ¥ Reject Submission
% I approbation de la soumission
[ Sign Off Confirmation
21, Version: Board Working Version
Ne Category 4
i H
‘SUBMISSION SIGN-OFF CONFIRMATION
Are you sure you want to promote the current Submission for approval? | Yes [ Oui
Are you sure you wrant to sign-off th issi Yes [ Oui =
Entries ]

ORACLE Enterprise Fusion Edition J_BOODD2_AP | Help.

Task List Status

k rd sign Task Instructions
| Scenario: Estimates 4 Pericd: YearTotall 4 Year: 2013-14 . SubCategory: No SubCategony
Second Training DSB -
= Active Flag
& 7 Reference Dt 4, Category: No Category
Submission Status | Activation Date |

& B vaidation Formats

£ B ubmission Mansgament V10:Board Adiive Version verrids | i ‘
& ¥ yersion Description and Summary
# ¥ Board Approver Sign-Off
# 9 Reject Submission

Apprabation de ls scumission

) Sign Off Gonfirmation

;Version: Board Working Verson

No Category.

w

‘SUBMISSION SIGN-OFF CONFIRMATION:

Are you sure you want to promote the current Submission for approval? | Yes [ Oui

Are you sure you want to sign-off th b

Recipient must contact the Ministry to initiate the over-ride approval.
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7.3.4 Checking the Submission History

Users will be able to view the submission’s history as well as any annotations the
Approver has made by selecting Validate and Promote for Approval and clicking the

Details button.

ORACLE' enterprise Performance Management System Workspace, Fusion Edition

Bl Forms [ Task List Status

My Task List Task - Validate and Promote for Approval-Manage Approvals  Task [nstuctons

5 7 Submission Tnput 2nd Quary - FS_Soumissio

. Scerario | Financial Statements [z Verson | Recipent Working Version [] | 69
|2 ® Submission Management - Modifier_Gestion _

§ Process Status

"Outof Office Assita

View +

= P Submission Management
& ¥ Version Description and Summany Chan Type [Pie [] Group By =1

lag Submission for Approval
& iialidata and Bromote for Approf

5 I Gastion de s soumission

[

Aors Ve 3@ % @ F @ H Desah

Planing Ut

= [Apmovak Sans 7 [SibSms ¥ [Curent Ovner 7 locsten T Path

DSAB.

| Under Review | |MCC_Recipent_ApproviTotal Recipients | 58

I

Status history and comments will be displayed, to view status changes collapse the pie

chart by selecting the arrow in the right corner

ORACLE Enterprise Performance Management System Workspace, Fusion Edition

M2014FIS - Task List Status *

¥ Forms Task List Status =
My Task List Task - Validate and Promote for Approval-Manage Approvals | Task Insucans
i & Submission Input and Query - FS_Soumissioll ' ;[ Finangisl Stmements [ Version | Recipient Werking Verson [ ] | 9 Out of Offce Assita
5 7 Submission Mansgament - Modifier_Gestion 8 —
& P Submission Mansgement Process Status
& ™ Version Description and Summary Planning Unt MS0003
& ¥ Flag Submission for Approvel o IS ¥ EF Detach
] vew-
& ¥ Validate and Promote far Appro| ey B s [ e
@ P Gestion de s soumission nder Review | EFLS. TRAINERDLGGMALL COf Promote 201502711 3:37
ot Signed OF | EFIS. TRAINERO2E@GMAIL.CO! Rejerr 2015/02/11 3:27 P!
| Under Review EFIS. TRAINEROIEGMAIL COI Promare 2015/02/11 3:23 P!
| Not Signed OFf EFIS. TRAINERO2EGMAIL.COI Reject | 2015/02/11 3:16 P!
L E EFIS.TRAINEROLEGMAIL.CO! Promete 201502111 2:51 P
[t RUBYSICONOMICS.CA Reject 20150210 312
[Under Review | EFIS. TRAINEROIEGMAIL.COM Promote 20150210 2:
| Not Signed Off EFIS.TRAINER02EGMAIL COM Reject | 2015/02/10 2:
| Under Review EFIS. TRAINEROIEGMAIL COM Promare | 2015/02/10 2:07 P!
& RUBYSICONOMICS.CA Reject 2015/02/09 2:07 P!
[t - EFIS.TRAINEROLGGMAIL.COM Promete 2015/02/05 3:37 P
[n EFIS.TRAINEROZEGMAIL COM Reject | 2015/02/06 3:28 P!
inder Review EFIS.TRAINEROIEGMAIL COM Promate | 2015/02/06 3:22 P!
indes Review RUBY@ICONOMICS.CA Originate | 2015/02/05 3: E
Existing Annotations HEa
Title: Modifier le statut - Not Signed OFf -
Author: EFIS. TRAINEROZEGMAIL.COM B
Date: 2015/02/10 2:32 PM
rivez vos commentaires i
Title: Modifier le statut - Under Review
Author: EFIS. TRAINEROI@GMAIL.COM L3
Date: 2015/02/10 2:07 PM
Text: Inscrivez vos commentsires ici -
Done
= i ’ L
W Prefare: Gomplere 7] Previows Incompleie | Previows | Newlncomplie | New | Tasklsibome |
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8 Appendix A

8.1 Overview of 3.1

8.1.1

Schedule 3.1 Tabs

The new EFIS 2.0 Schedule 3.1 is now broken down into 5 tabs

| Entitlement | Admin, Overspending Adjustment | Transfer Payment | Breskdown of Capital | Utilization

Allocation | Minimum Cost Share Requirement | - Allocation and Cost Share | Expenditures | Entitiement Before Fleoability from Core Service Delivery Cost Shared - 100:0 | Entitlement Bafore Flesability|
Core Services Delivery 100% and Other Full Flesibility Sectors 2,323,268 2,323,268
Core Services Delivery - Cost Share Requirement £0:20 1,416,942 354,236 1,771,178
Core Services Deliveny - Cost Share Reguirement 50:50 - Administration | 154,388 154,388 388,776
Special Neads Resourcing 300,000 300,000
Administration 10,000 0
Other Operating Sectors Exchuding Limited Flesdbility 4,446,800 2,003,268
Capacity Building 11,785 11,785 11,875 11,785
Capital Retrofits 15,178 15,178 0 0
Small Water Works 4125 4,125 4,125 4,125
£ Total Sactors Excluding TWOMO and Adjustments 3,965,686 548,624 4514310 4,772,800 2,339,178
TWOMO Reimbursement 120,039 120,039 120,000 120,000
Missed Target Adjustment
Adminisration Overspending Adjustment
= Total Sactors for Entitlement 4,085,725 548,624 4534343 | 4,892,800 2,459,178

Entitlement

Displays allocations, expenses and calculates the entitlement, cost share and
recoveries.

Additional information has been added to display the calculation and impacts of
flexibility

Admin, Overspending Adjustment

Displays the calculation for the Adjustment if Maximum Administration
Expenditure is exceeded

Transfer Payment

Displays a summary of the Operating and Capital transfer payment amounts by
Entitlement

Displays any Ministry Adjustment that has been applied
Breakdown of Capital
Provides an breakdown of the capital expenditures

Utilization
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e Displays the calculation of Overspending or Underspending for Utilization
purposes

8.1.2 Entitlement Tab

Below is a brief description of the columns for the Entitlement Tab

Schedule 3.1 - Entitlement -
Entitlement Calculation

Entilement Bafore | Entiflement Before
Flexibiity from Core | Flexibiity from Core
Service Delivery Service Delivery
Minimam Cost |Allocation and Cost Caost Shared - Carst Shared -
Aliocation| Share Reguirsment Share Expenditures 100:0 B0-20
Col_1 Col. 2 Col. 3 Col. 4 Col. 5 Col. 6
11 Core Services Delvery 100% and Cther Full Flexibility Sectors 2323203 - 2323268
1.2 Core Services Delvery - Cost Share Requirement 80:20 1,418,842 354,228 1.771.178
13 Core Services Delwery - Cost Share Requirement 50:50 - Administration 184,333 194 383 383,776
2. Special Meeds Resourcing - - - 300,000 300.000 [1]
2 (Admanistration . . - 10.000 1] 1]
Other Operating Sectors Excluding Limited Flexibility - - - 4444800 2023268 1.416.242
31 Capacity Building 11785 - 11785 11675 11,765
3.2 Capital Retrofits 15,178 - 15,178 0 0
2.3 | Small Water Works 4125 - 4126 4,125 4125
4 Total Sectors Excluding TWOMO and Adjustments 2,065,688 548,624 4,514,310 4772800 2,330,178 1.416.242
5 TWOMO Reimbursement 120,039 - 120.030 120,000 120.000
6.1 Missed Target Adjustment
6.2 [Administration Overspending Adjustment
T Total Sectors for Entitlement 4085725 548 624 4634340 4 BBZBOD 2450178 1416842

Column 1 — Allocation

e Displays the allocation by sector, derived from Schedule 3.0
Column 2 — Minimum Cost Share Requirement

e Calculated the minimum cost share for 50:50 and 80:20 funding
Column 3 — Allocation and Cost Share

e Sum of Allocation and Cost Share
Column 4 — Expenditures

e Actual Expenditures from Schedule 2.3 (Adjusted Gross Expenditures) and
Schedule 2.7 (TWOMO Expenditures)

Column 5 — Entitlement Before Flexibility from Core Service Delivery Cost Shared —
100:0

e Displays the 100% funded entitlements before flexibility has been applied
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Column 6 Entitlement Before Flexibility from Core Service Delivery Cost Shared — 80:20

e Displays the 80% funded entitlements before flexibility has been applied

Schedule 3.1 - Entitlement -
Entitlement Calculation

Entitiement Before Application of Application of
Flexibility from Core Flexibiity from Core | Flexibdity from Core
Service Delivery Semvice Delivery Service Delivery
Cost Shared - | Enfittement Before | Cost Share Before Cest Shared - Cost Shared -
50:50 Flexibility Flexibility| Pressure or Surplus 1000 B0-20
Col. 7 Col. 8 Col. @ Col. 10 Col. 11 Cal. 12
(Col.5+#Col.6+( (ColG44+ColT)
Col.7)
1.1 Core Services Delvery 100% and Other Full Flexibility Sectors -
12 Core Services Delivery - Cost Share Requirement 80:20
13 Core Services Delivery - Cost Share Requirement 50:50 - Administration
2.1 Special Needs Resouwrcing a 300.000 [1] -
Administration 5,000 5,000 5,000 -189,388
Cther Operating Sectors Excluding Limited Flexibility 189,383 3,629,508 543.624 273,578
31 Capacity Building - 11765 - ] ] 1]
3.2 Capital Retrofits - 1] - -18,178 o 1]
3.3 Small Water Works - 4125 - 0 0 0
4 Total Sectors Excluding TWOMOD and Adjustments 104,383 3,050,508 543,624 60,102 0 0
5 TWOMO Reimbursement - 120,000
6.1 Missed Target Adjustment
6.2 Administration Overspending Adjustment
d Total Sectors for Entitlement 104,383 4,070,508 543,624 60,102 ] 0

Column 7- Entitlement Before Flexibility from Core Service Delivery Cost Shared —
50:50

e Displays the 50% funded entitlements before flexibility has been applied
Column 8 — Entitlement Before Flexibility

e Total entittlement before application of flexibility
Column 9 — Cost Share before Flexibility

e Displays the Cost Share before flexibility has been applied
Column 10 — Pressure or Surplus

e Displays the Pressure (expenditure greater than allocation) or the Surplus
(allocation greater than expenditure)

Column 11 — Application of Flexibility from Core Service Delivery Cost Shared — 100:0

e Displays the amount of flexibility that has been applied from 100% funded
entitlements

Column 12 — Application of Flexibility from Core Service Delivery Cost Shared — 80:20
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e Displays the amount of flexibility that has been applied from 80% funded
entitlements

Schedule 3.1 - Entitlement -
Entitlement Calculation

Application of
Flexibility from Core
Service Delivery Child Care
Cost Shared - Application of Cost Share of Adpustment /
50:50 Flexibility Flexibility|  Total Enfilement| Actual Cost Share (Recovery)
Col. 13 Col. 14 Col. 15 Col. 16 Col. 17 Col. 18
(Col. 11 + Col. 12 #|  (Col. 12/4 + Col. {Col. &+ Col. 14)| (Col. @ + Cal. 15)
Col. 13) 13)
1.1 Core Services Delwery 100% and Other Full Flexibility Sectors -
12 Core Services Delwery - Cost Share Requirement 80:20
1.3 Core Services Delvery - Cost Share Requirement 50:50 - Administration
2.1 Special Needs Resourcing - - - 300,000 o -
Administration - - - 5.000 5,000 1]
Other Operating Sectors Exchuding Limited Flexibility - - - 3,620,508 543624 o
3.1 Capacity Building [1] 1 1] 11.785( 1] 1]
3.2 Capital Retrofits a 1] 1] o o -15.178
3.3 Small Water Works a 1] 1] 4,125 o 0
4 Total Sectors Excluding TWOMO and Adjustments a a [1] 3,050,508 543,624 -15.178
5 TWOMO Reimbursement - - - 120,000 - -30
8.1 Missed Target Adjuestment - - - o - i}
6.2 [Administration Overspending Adjustment - - - o - o
[T Total Sectors for Entiflement EI—| 0 1] 4,070 5ﬁ| 548 624 15217

Column 13 — Application of Flexibility from Core Service Delivery Cost Shared — 50:50

e Displays the amount of flexibility that has been applied from 50% funded
entitlements

Column 14 — Application of Flexibility
e Total amount of flexibility that has been applied
Column 15 — Cost Share of Flexibility
¢ Amount of cost share amounts related to the application of flexibility
Column 16 — Total Entitlement
e Total Allocation including TOWMO, and adjustments
Column 17 — Actual Cost Share
e Total Cost Share
Column 18 - Recovery by Ministry

e Amount of Ministry recovery
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8.1.3 Adjustment for Administration Spending Tab

Screen Shot

Entitlemant | Admin. Overspending Adjustment - Transfer Payment | Breskdown of Capitzl | Utilization
Financiz| Statemants
No SubCategory

Administration Masimum Allowable Expenditure Limit 396,569

Administration Expenditures 10,000

Administration Ower (Under) Ministry Masximum Allowzable Expenditure Limit {386,569)

Administration Compliant Yes | Oui

Administration Owerspending Adjustment | Municipal Contribution in Excess of Cost Share Requirement 273,668

Administration Owerspending Adjustment | Child Care Adjustment | (Recoveny]) 0

Report
Schedule 3.1 - Entitlement -
Adjustment for Administration Overspending
321 Maximum Allowable Expenditure Limit 306,569
0% x 2014 Total Allocation (include SWW but exclude TWOMO)

322 |Expendiures 10,000
323 |Over (Unden) Ministry Maximum Allowable Expenditure Limit 386,569
324 ‘Compliant Yes / Oui
325 Municipal Contribution in Excess of Cost Share Requirement 273,668
326 |Administration O 0

e Line 3.2.1 — calculation of maximum allowable expenditure limit (10% x 2014
Total Allocation (include SWW but exclude TWOMO)

e Line 3.2.2 — Total administration expenditures from Schedule 2.3
e Line 3.2.3 — Over / under calculation (3.2.2 — 3.2.3)
e Line 3.2.4 — Compliant check (if 3.2.3 is negative then Yes, else No)

e Line 3.2.5 — Amount of Municipal contribution in excess of cost share
requirement

e Line 3.2.6 — Administration Overspending Adjustment to total Entitlement
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8.1.4 Transfer Payment Summary Tab

Screen Shot

Entitlement | Admin, Overspending Adjustment | Transfer Payment . Brezkdown of Capital | Utilzation
Financizl Statemants
Mo SubCategory

OPERATING | FONCTIONNEMENT
Total Entitlement Specizl Neads Resourcing 300, D00
Total Entitlement Capacity Buikding 11,785
Total Entithament Small Water Warks 4,125
Total Entitlement TWOMO Reimbursement 120, 000
Total Entitlement Administration L 00D
Total Entitlement Orther Orpesating Sectors Excheding Limited Flesdbility 3,625,558
Total Entitlement Administration Owerspending Adjustment 0
Total Entitlement Missad Target Adjustment 0
Entitlement Ministry Adjustment for Operating Sectors 0
Total Entitlement Total Operating Sectors for TP 4,070,508
CAPITAL / IMMGBILISATIONS
Total Entitlement Capital Retrofits

Entitlement Ministry Adjustment for Capital Sectors
Total Entitlement Total Capital Sectors for TP
TOTAL .
Total Entitlement Total Sectors for TP 4,070, 508

Report

Schedule 3.1 - Entitlement -
Transfer Payment Summary

|;I'm.z| Entitlement - Total Operating Sectors for TP

2.3.1 Specal Needs Resourcing

300,000

332 | Capacity Building

11.785

3133 Small Water Works 4,125
234 TWOMO Reimbursement 120,000
335 Administration 5.000
336 (Other Operating Sectors Excluding Limited Flexibility 3,620,508
3137 [Adminisiration Owerspending Adjustment 1]
I3E  |Miss2d Target Adjustment [1]
EEE Ministry Adjustment for Operating Sectors {for Ministry Uise only) 1]
3.3.10 Total Operating Sectors for TF 4070508
....5um of tems 3.3.110 330
Total Entitlement - Total Capital Sectors for TP
3311 Capital Retrofits o
3.3.12 Ministry Adjustment for Capital Sectors (for Ministry Use only) i}
3313 [Total Capital Sectors for TP 1]
....Bum of items 3.3.11 t2 3312
3314  [Total Entitlement - Total Sectors for TP 4,070,508

--...5um of item 3.3.10 and item 3.3.13

e Provides a summary of the Operating and Capital Transfer payment amounts,
including the Ministry adjustment.
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8.1.5 Breakdown of Capital Tab

Screen Shot

Entitlement | Admin, Owerspanding Adjustment | Transfer Paymeant | Breakdown of Capital - Utilzation

Financiz| Statements
No SubCategory
Capitzl Retrofits
Portion of Expanditures Funded by Camy Forwand Amount 23,785
Portion of Expenditures Funded by Allocation ]
Crperating Funds Used for Capital - Ministry 1]
Orperating Funds Used for Capital - Municipality 0
2014 Committed Camy Forward Amount to 2015 15,178
Report
Schedule 3.1 - Entitlement -
Breakdown of Capital
Capital Retrofits
341 Portion of Expenditures Funded by Camry Forward Amount 23,785
342 Portion of Expenditures Funded by Allocation 0
343 (Operating Funds Used for Capital - Ministry 0
344 Operating Funds Used for Capital - Municipality 0
345 |2014 Commitied Cary Forward Amount o 2015 75,178

e Line 3.4.1 — The amount of capital expenditures that are funded from carry
forward amount

e Line 3.4.2 - The amount of capital expenditures that are funded from current year
allocation

e Line 3.4.3 — The amount of Ministry operating funds that were used to fund
capital expenditures

e Line 3.4.4 — The amount of Municipal operating funds that were used to fund
capital expenditures

e Line 3.4.5 Amount of Committed carry Forward amounts to the following year
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8.1.6 Utilization Tab

Screen Shot

Entitlemnent | Admin, Owverspanding Adjustment ™._Transfer Payment | Breaskdown of Capital | Utilization

Financial Statements
MNo SubCategory:
Total Sectors for Utilization | Municipal Contribution in Excess of Cost Share Requirement 273,668
Total Sectors for Utilization | Child Care Adjustment | {(Recovery) {15,217)
Taotal Sectors for Utilization | Expenditures Relsted to Prior Year Capital Camy Forward 23,785
Total Sectors for Utilization | Underspending Relsted to Small Water Works 1]
Total Sectors for Utilization | Owerspending or Underspanding relsted to TWOMO 19
Total Sectors for Utilization | Missed Tanget Adjustment to Utilization 1]
Total Sectors for Utilization. | Ministry Adjustment for Utilization - Desaription
Total Sectors for Utilization, | Ministry Adjustment for Uitilization - Amount
Total Sectors for Utilization | Owerspending or Underspending for Liilzation 282,275
Report
Schedule 3.1 - Entitlement -
Overspending or Underspending for Utilization

351 Municipal Contribution in Excess of Cost Share Requirement 273,668
352 |Child Care Adjustment  (Recovery) 5,217
353 Expenditures Related to Prior Year Capital Carry Forward 23,785
354  |Underspending Related to Small Water Works 0
355 Overspending or Underspending related to TWOMO 39
356 Missed Target Adjustment to Utilization [i]

357

Ministry Adjustment for Utilization - Description

358

Ministry Adjustment for Utilization - Amount

359

Overspending or Underspending for Utilization 282,275

Line 3.5.1 — Amount of Municipal Contribution in excess of share requirement
from Schedule 4.0 line 2.3

Line 3.5.2 — Recovery by Ministry from Schedule 3.1 Entitlement column 21 line
7

Line 3.5.3 — Expenditures related to prior year carry forward from Schedule 3.1
Breakdown of Capital line 3.4.1

Line 3.5.4 — Underspending Related to Small Water Works from Schedule 3.1
Entitlement column 21 line 3.3

Line 3.5.5 — Overspending related to TWOMO

Line 3.5.6— Missed Target Adjustment from Schedule 3.1 Entitlement column 19
line 6.2

Line 3.5.7 — Ministry Adjustment Description
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Line 3.5.8 — Ministry Adjustment Amount

3.5.6 — Overspending or Underspending for Utilization — Sum of 3.5.1 to 3.5.5
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